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01.0 Introduction

Thank you for purchasing ProJet™ 3-D Printing System. We pride ourselves in our ability to offer customers three dimensional printing solutions.
The 3D System team is confident your system will provide many years of service.

1.1 About this Guide
1.2 Copyright
1.3 Useful Documents
1.4 What's Inside
1.5 Features and Benefits
® 1.5.1 Description and Definitions
1.6 ProJet™ Systems Software
® 1.7 Packaging
® 1.8 TIPS for our Customers



1.6 ProJet™ Systems Software

To install ProJet™ series upgrades, click on ProJet™ Systems Software to download the software and the software release notes that provide
detailed installation instructions.


http://3dpedia.3dsystems.com/display/3DS3/ProJet+Software+Downloads

1.8 TIPS for our Customers

We want you to have the very best possible experience with the material delivery system on your new ProJet® 3500 system. These tips are
important to ensure you understand the key points about the system; it is included in the accessory kit that shipped with your printer. Please see
TIPS FOR OUR CUSTOMER in 3DS Central to get TIPS for Material Handling on the ProJet 3500.



1.1 About this Guide

This guide is created to give you an understanding of key features, system requirements and operating procedures for your ProJet™ 3500 printer.
Click on the links which will lead you to the section of choice.

For support documentation, see Other Documents. To order material cartridges or parts, please contact your Authorized reseller or contact 3D
Systems Customer Support to locate your nearest Authorized Reseller. Safety Guidelines: Read and understand all safety guidelines before
attempting to operate your printer. These guidelines provide important details on how to handle the VisiJet® material cartridge properly and also
describe how to avoid personal injury and/or damage to the printer. For more detailed information on material safety, see VisiJet® Material
Guidelines.

System Requirements: This section provides all the necessary facility requirements for electrical, hardware, dimensional and
environmental data.

Familiarization: A pictorial view and description of printer functions and controls.

Operations: Describes functionality and the build process when starting a new or an existing design.

Error Messages: Flow chart describing the reason for printer's error message, what cause the error and the solution.

Maintenance: Provides detail information when performing software, hardware and preventative maintenance to the printer.
Troubleshooting: Describes how to diagnose problems pertaining to the printer's hardware and software.

Spare Parts Locator: Quick access to parts that can be order through 3D Systems Customer Support.

Other Documents: The Warranty and Maintenance Agreements information, along with the Material Safety Data Sheet (MSDS/SDS).
Support: 3D Systems Customer Support will provide you information on how to obtain software updates; how to order parts and return
parts through 3D Systems' Return Material Agreement (RMA). Information on how to get system upgrades and updates.

Help: Quick access to answers to frequently asked questions (FAQ).

Glossary of Terms: Alphabetical listing of terms that are frequently used through thsi user guide and their description.

Index: Listing in alphabetical order for quick reference when you are uncertain of the section the term may be used in the guide.



1.2 Copyright

© 2012 by 3D Systems, Inc. All rights reserved. Subject to change without notice. This document is copyrighted and contains proprietary
information that is the property of 3D Systems, Inc. The licensed user, in the name of whom this document is registered (the "Licensed User")
does not have the right to copy, reproduce, or translate this document in any way or to any media without the prior written consent of 3D Systems,
Inc. No copies of the document may be sold or given to any person or other entity.

ProJet™is a trademark and the 3D logo and VisiJet® are registered trademarks of 3D Systems, Inc.

Improvements

3D Systems may (but shall not be obligated to) make improvements to this document from time to time. However, the Licensed User
acknowledges that at any time after the expiration of the date of issuance, 3D Systems may institute a periodic charge or fee payable by the
Licensed User in return for ongoing receipt of improvements. It is the responsibility of the Licensed User to provide 3D Systems with current
information as to its name and address. The Licensed User also undertakes to notify 3D Systems promptly in the event that it considers any of the
data contained in this document to be incomplete or erroneous in any respect, in connection with Licensed User's particular use or generally.

FCC Notice

This equipment has been tested and found to comply with the limits for a class A digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may
cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in
which case the user will be required to correct the interference at his own expense.

Changes or modifications not expressly approved by 3D Systems could void your authority to operate this equipment.

Limitations of Warranty and Liability

This information is provided by 3D Systems for the convenience of its customers. It is believed to be reliable, but NO REPRESENTATIONS,
GUARANTEES, OR WARRANTIES OF ANY KIND ARE MADE AS TO ITS ACCURACY, FITNESS FOR A PARTICULAR USE, OR THE
RESULTS TO BE OBTAINED THEREFROM. The information is based in whole or in large part on laboratory work and does not necessarily
indicate performance in all conditions. Notwithstanding any information provided by 3D Systems or its affiliates, the customer remains fully
responsible for determining which federal, state, or local laws or regulations, or industry practices are relevant to activities in which it engages, as
well as assuring that those laws, regulations, or standards are complied with under actual operating conditions, and 3D Systems undertakes no
responsibility in these areas.

IN NO EVENT WILL 3D Systems BE RESPONSIBLE FOR DAMAGES OF ANY NATURE, INCLUDING SPECIAL OR CONSEQUENTIAL
DAMAGES, RESULTING FROM THE USE OF OR RELIANCE UPON THIS INFORMATION. THE CUSTOMER ASSUMES ALL RISK
RESULTING FROM THE USE OF THIS INFORMATION. Customers use of the materials that follow is an acknowledgment of its agreement to
the foregoing. Any customer not wishing to be bound should return this material to 3D Systems. Nothing contained herein is to be considered as
permission, recommendation, nor as an inducement to practice any patented invention without permission of the patent owner.



1.3 Useful Documents

The documents listed below will help get the most out of your system, To access, click on the document title.

ProJet™ 3-D Printing Client Online Help: Run the client software, select Help > Help Topics in the printer's window or in Build Preview window to
launch the client online help. The online help provide detailed instructions on how to use the client software to setup, run, and manage build jobs.

ProJet_3500_Quick Reference Guide.pdf: Download to have quick reference on the control panel functions, how to load / remove cartridges, and
how to run a test build.

VisiJet® Material Handling and Post-Processing Guide: This document has everything needed to guide you in safely handling and disposing of
VisiJet® material, including relevant regulatory guidelines for material disposal worldwide. It also provides information on how to clean parts once
the build process is completed.

Projet™ 3-D Printers Facility Requirements Guide: This guide provides the dimensional data that is required when the 3D System's Field Service
Engineer installs the printer. Click on the part number to view a copy for reference.

VisiJet® Material Safety Data Sheets (MSDS's): Ensure everyone who handles VisiJet™ materials is familiar with MSDS's and follows the safety
guidelines. To order extra copies of MSDS's, request the appropriate document part numbers are located on the bottom left-hand corner of the
MSDS.


http://3dWorks.3dsystems.com/download/attachments/73859131/ProJet_3500_Quick+Reference+Guide.pdf?version=1&modificationDate=1336152189580
http://3dWorks.3dsystems.com/display/VJHG/Table+of+Contents
http://3dWorks.3dsystems.com/pages/viewpage.action?pageId=11698237
http://www.3dsystems.com/products/index

1.4 What's Inside

Safety: Read prior to handling VisiJet® Materials or operating the printer. The safety sections inform you of handling the material properly and
avoid damage and injury when operating the printer. For more detailed material safety information, refer to VisiJet® Material Handling Guide.

System Requirements: Provides electrical requirements prior to plugging in your printer for operation. For more detailed facility requirements
information, see the ProJet™ 3-D Printers Facility Requirements Guide.

Familiarization: Provides a brief description of the printer system.

Printer Setup: Provides information on preparing the 3-D printer for builds using the software, and how to send test and demo builds to the
printer from your computer. Also refer to your online help for software instructions.

Operations: Describes loading and running the printer; start and stop build jobs; monitor and control build jobs; unload build parts; and disposing
waste material.

Error Messges: Defines the error messages you may see on the printer's operator's panel and provide the actions to take.
Finishing:Provides information on finishing parts.

Maintenance: List printer maintenance procedures which must be done to ensure high part yield and low printer down time. Semi-annual
preventive maintenance requires a certified 3D Systems Technical Support Representative.

Troubleshooting: If problems occur with the printer, look for solutions in this section first. It describes some common problems which can occur
and suggests corrective actions.

Technical Support: List of contact numbers of sale and support personnel for your printer system.



1.5 Features and Benefits

ProJet™ HD3500 prints precision, durable plastic parts ideal for functional testing, design communication,
rapid manufacturing, rapid tooling and more. It features selectable resolution choices for speed and quality.
Printing Mode: High Definition(HD), Ultra High Definition (UHD)

Net Build Volume (xyz): HD Mode: 298 x 185 x 203mm (11.75 x 7.3 x 8 inches); UHD Mode: 127 x 178 x
152mm (5 x 7 x 6 inches)

Resolution (xyz): *HD Mode: 328 x 328 x 606 DPI (xyz); 40u layersJHD Mode: 656 x 656 x 800 DPI (xyz); 32
layers

VisiJet® Materials: Part Materials: VisiJet® Crystal; Support Material: S300

Part Stacking and Nesting: features part stacking and nesting capability in both build modes. The user can
now utilize the entire build volume by stacking parts vertically in the z-direction to fill up the entire build envelop
with parts. The user can control the space between layers to minimize support material usage and build time.
Now, hours can be saved by stacking parts and submitting single, long builds overnight and weekends.

ProJet™ HD3500plus features a 60% expanded high definition build envelope and advanced print detail
output. A 16 micron print resolution delivers exceptional hard plastic parts with unmatched micro-detail and
surface quality.

Printing Mode: High Definition (HD), Ultra High Definition (UHD), Xtreme High Definition (XHD)

Net Build Volume (xyz): HD Mode: 298 x 185 x 203mm (11.75 x 7.3 x 8 inches); UHD Mode: 203 x 178 x
152mm (8 x 7 x 6 inches);

XHD Mode: 203 x 178 x 152mm (8 x 7 x 6 inches)

Resolution (xyz): HD Mode: 328 x 328 x 606 DPI; 40u layersJHD Mode: 656 x 656 x 800 DPI; 32y layers;
XHD Mode: 656 x 656 x 1600 DPI ; 16u layers

VisiJet® Materials: Part Materials: VisiJet® Crystal, VisiJet® Proplast (natural),VisiJet® Navy, VisiJet®
Techplast (Grey), VisiJet® Procast; Support Material: S300

Email Notification: Provides email notification to the user when their job begins, completes, aborts and if the
system is low on material at any time during their build. Users can set their defaults and make changes as to
what emails they will receive via the Job Options window.

ProJet™ CPX3500 mass produces 100% wax patterns with unmatched surface quality, extreme fine detail and
exceptional precision. RealWax patterns are ideal for casting jewelry, apparel, micro-detail medical instruments
and devices, medical implants, electrical components, figurines, replicas, collectables and more.

Printing Mode: High Definition(HD), Xtreme High Definition (XHD)

Net Build Volume (xyz): HD Mode: 298 x 185 x 203mm (11.75 x 7.3 x 8 inches); XHD Mode: 127 x 178 x
152mm (5 x 7 x 6 inches)

Resolution (xyz): *HD Mode: 328 x 328 x 700 DPI (xyz); 36u layersXHD Mode: 656 x 656 x 1600 DPI (xyz);
16p layers

VisiJet® Materials: Part Materials: VisiJet® Hi-Cast; Support Material: S400

Part Stacking and Nesting: features part stacking and nesting capability in both build modes. The user can
now utilize the entire build volume by stacking parts vertically in the z-direction to fill up the entire build envelop
with parts. The user can control the space between layers to minimize support material usage and build time.
Now, hours can be saved by stacking parts and submitting single, long builds overnight and weekends.

ProJet™ CPX3500plus features a 60% expanded high definition build envelope with up to 20% increased print
speed. A new 20 micron high resolution option delivers exceptional wax patterns with smooth surface quality
and fine feature detail in less time.

Printing Mode: High Definition (HD), Ultra High Definition (UHD), Xtreme High Definition (XHD)

Net Build Volume (xyz): HD Mode: 298 x 185 x 203 (11.75 x 7.3 x 8 inches); UHD Mode: 203 x 178 x 152mm
(8 x 7 x 6 inches);

XHD Mode: 203 x 178 x 152mm (8 x 7 x 6 inches)

Resolution (xyz): HD Mode: 328 x 328 x 700 DPI (xyz); 36u layersJHD Mode: 656 x 656 x 1300 DPI; 20u
layers; XHD Mode: 656 x 656 x 1600 DPI, 16y layers

VisiJet® Materials: Part Materials: VisiJet® Hi-Cast; Support Material: S400

Email Notification: Provides email notification to the user when their job begins, completes, aborts and if the
system is low on material at any time during their build. Users can set their defaults and make changes as to
what emails they will receive via the Job Options window.

ProJet™ CP3500 mass produces 100% wax patterns with smooth surface quality and exceptional precision,
supporting almost unlimited applications capabilities. RealWax patterns are ideal for general foundry casting
applications such as medium-sized to large mechanical parts for engines, pneumatics, aerospace, energy
production and delivery, custom manufacturing equipment, restorations and other heavy equipment.

Net Build Volume (xyz): 298 x 185 x 203mm (11.75 x 7.3 x 8 inches)

Resolution (xyz): 328 x 328 x 700 DPI; 36y layers

VisiJet® Materials: Part Materials: VisiJet® ProWax; Support Material: S400

Part Stacking and Nesting: features part stacking and nesting capability in both build modes. The user can
now utilize the entire build volume by stacking parts vertically in the z-direction to fill up the entire build envelop
with parts. The user can control the space between layers to minimize support material usage and build time.
Now, hours can be saved by stacking parts and submitting single, long builds overnight and weekends.




ProJet™ SD3500 prints high definition, durable plastic parts for engineering and mechanical design
applications including functional testing, form and fit verification, rapid prototyping, design communication, rapid
tooling and more.

Net Build Volume (xyz): 298 x 185 x 203mm (11.75 x 7.3 x 8 inches)

Resolution (xyz): 328 x 328 x 606 DPI (xyz)

VisiJet® Materials: Part Materials: VisiJet® Crystal, VisiJet® Proplast (natural),VisiJet® Navy, VisiJet®
Techplast (Grey); Support Material: S100

ProJet™ DP3500 accurately, consistently and economically manufactures precision wax-ups for dental
professionals. The system can generate hundreds of units each cycle. The wax-ups have a smooth surface
finish and can be cast or pressed with conventional techniques. The large build volume and optional part
stacking and nesting capabilities enable unattended operation ideal for high-volume production.

Printing Mode: High Definition (HD); Ultra High Definition (UHD)

Net Build Volume (xyz): HD Mode: 298 x 185 x 203mm (11.75 x 7.3 x 8 inches); UHD Mode: 203 x 178 x
152mm (8 x 7 x 6 inches)

Resolution (xyz): *HD Mode: 328 x 328 x 606 DPI; UHD Mode:328 x 328 x 606 DPI

VisiJet® Materials: Part Materials: VisiJet® Dentcast; Support Material: S300

Email Notification: Provides email notification to the user when their job begins, completes, aborts and if the
system is low on material at any time during their build. Users can set their defaults and make changes as to
what emails they will receive via the Job Options window.

ProJet™ MP3500 can produce any size parts with smooth surfaces. Multiple parts can be built at one time.
Works with any compatible intraoral, plaster or impression scanner. This Printing System is designed for use in
laboratories with extended unattended operation, same day processing - helps you reduce time and cost.
Printing Mode: High Definition Plaster (HDP)

Net Build Volume (xyz): HDX Mode: 298 x 185 x 203mm (11.75 x 7.3 x 8 inches); UHD Mode: 127 x 178 x
152mm (5 x 7 x 6 inches)

Resolution (xyz): HDX Mode: 656 x 656 x 800 DPI

VisiJet® Materials: Part Materials: VisiJet® Stoneplast; Support Material: S300

® 1.5.1 Description and Definitions



1.5.1 Description and Definitions

Depending on the model of your ProJet 3500 3-D Production System, your system features different types of build styles to meet a variety of part
making applications. Please refer to Features and Benefits that will describe your extended choices for your particular system.

Description and Definitions

The High Definition (HD) Mode allows the user rapid part making capability on a full platform. This mode produces high quality parts for
concept parts, verification designs and patterns for casting.

The Ultra High Definition (UHD) Mode allows the users to build extremely high resolution parts with exceptional surface finish and
superior accuracy. Parts build in UHD mode are typically used for show parts, fit testing and direct manufacturing using patterns for
investment casting of jewelry and small components.

Expanded UHD Mode: Provides the user with an Expanded Ultra High Definition (UHD) mode build envelope.

Expanded XHD Mode: Provides the user access to the new Extreme High Definition (XHD) Mode that features a new print resolution
with the same expanded build envelope available in UHD.

Email Notification: Provides email notification to the user when their job begins, completes, aborts and if the system is low on material
at any time during their build. Users can set their defaults and make changes as to what emails they will receive via the Job Options
window.

Part Stacking and Nesting

The new ProJet 3-D Production System, features part stacking and nesting capability in both build modes. The user can now utilize the entire
build volume by stacking parts vertically in the z-direction to fill up the entire build envelop with parts. The user can control the space between
layers to minimize support material usage and build time. Now, hours can be saved by stacking parts and submitting single, long builds overnight
and weekends.

Bounding Box Display Added to Print Preview

A few new features have been added to Print Preview to allow it to handle up to two gigabytes of part data on a single build.

® The Bounding Box Display has been added to Print Preview to allow file sizes that were previously too large for Print Preview to load

successfully. The Bounding Box Display only displays the bounding extents of a given geometry and does not try to resolve the triangles
required to display an entire geometry. See Section 8.1 Preview Build Job.

Job Submission Checking has also been added. Both the 3-D Printing Client and Print Preview now check to make sure that the
maximum allowable accumulated build file size on the machine is not exceeded during job submission. The maximum threshold for job
submission is roughly two gigabytes or 40,000,000 triangles. See Section 8.3 Submit a Build Job

The new ProJet™ HD 3500plus production system introduces new enhancements including an expanded build envelope for the UHD
build mode, the new XHD build mode and email notification.



1.7 Packaging

Packaging
Do not damage or discard any packaging materials or carton(s). If the printer needs to be returned to the manufacturer, it should be shipped in it's
original packaging. If other packaging is used, the customer will be responsible for any shipping damages that may occur.

Only Certified/Qualifed Service Personnel can install the 3-D printer.




02.0 Safety Symbols & Definitions

UV Radiation Hazard: Invisible UV radiation is accessible in the vicinity of this sign or behind the panel. Radiation can cause
eye injury. Access panels are for service only and should be opened only by certified service personnel.

Electrical Shock Hazard: High voltage electricity is accessible in the vicinity of this sign or behind the access panel. High
voltage can cause severe burns or death. Access panels are for service only and should be opened only by certified service
personnel or trained maintenance personnel.

Hot Surface Hazard: A hot surface is accessible in the vicinity of this sign or behind the access panel. Avoid contact. Hot
surfaces can cause severe burns. Access panels are for service only and should be opened only by certified service personnel
or trained maintenance personnel.

Harmful Irritant Warning: Indicates that skin or eye irritation could result while exposed to a chemical composition.

Caution: Indicates something may happen that could cause loss of data, damage to equipment, or personal injury.

Wear gloves when handling uncured VisiJet® build material.

Ultraviolet radiation inside. Exposure may cause eye damage. Do not operate without covers. Wear UV eye protection.



03.0 Safety Guidelines

Before using the printer, your company should have a safety program in place. The safety program should:

® |abel and point out hazardous equipment, materials, and procedures.

® Explain what to do in case of an emergency.

® Provide information about hazards of equipment and materials in the form of Material Safety Data Sheets (MSDSs). The MSDSs are
provided with all materials supplied by 3D Systems.

® 3.1 General
® 3.2 Electrical
® 3.3 Ultraviolet (UV) Light



3.1 General

The printer is designed with built in safety features, improper use and malfunctions can cause injury to personnel. To prevent unsafe operation,
the printer will automatically shut down if unsafe conditions are detected.

Follow these safety guidelines when operating the printer:

Read and follow all printer instructions.

Follow all safety rules and heed all cautions and warnings in this guide.

Do not attempt to open chamber door while build in progress.

Do not use any material without reviewing the Material Safety Data Sheets (MSDS/SDS.

Dress power and communication cables behind printer to prevent tripping.

Do not attempt to access, service, or adjust printer components. Do not attempt to perform any maintenance procedures unless
specifically trained to do so.

Operators who are trained to operate system and perform all necessary tasks to create a part.

Certified service personnel are those who completed the 3D Systems service training package and certified to perform service tasks.
Certification may occur at different levels, and service providers should only perform tasks they are authorized and certified to complete.
Do not ignore warning signs posted during printer service operations.

If an error message appears on the printer's LCD refer to Section 10.0 Error Messages within this guide before resuming operation.

To prevent potential skin-irritation and sensitization due to contact with waste material, follow all guidelines within Build Material Safety.
To prevent pinch and crush injuries to the hand, use caution when replacing platform inside the build chamber.


http://production3dprinters.com/support/3dp-material-safety-data-sheets-msds

3.2 Electrical

DANGER: Hazardous voltage exists inside the printer. Injury or death from electrical shock can result if you remove the
printer's external panels. Panels should only be removed for service by trained and certified 3D Systems Technical

Support personnel or your certified service reseller.
To prevent electrical shock, the printer will not operate unless external panels are installed. Check the facility's electrical

service rating before you connect power to the printer.



3.3 Ultraviolet (UV) Light

CAUTION: Hazardous UV radiation exists inside the printer build chamber during build job. Eye injury or blindness can
result if chamber door is opened while a build job is in progress. If a build job is running, abort build job before attempting
to open chamber door.

To prevent eye injury, ultraviolet (UV) light inside the chamber will not operate when chamber door is open. When closed,
the chamber door keeps UV radiation from escaping. The chamber door remains locked if build job is paused.



04.0 Part Material Safety

Users of the printer should be informed of potential hazards of part material prior to working with a printer, or performing duties which may result
in exposure to uncured part material, such as removal of material waste pan and empty material cartridges.

Always wear gloves when handling part material that is uncured
and not totally solidified.

4.1 Disposal

4.2 Health Hazards

4.3 Material Handling

4.4 Personal Protection Equipment
4.5 Regulatory Information

4.6 Spilled VisiJet® Material

4.7 Waste Removal

4.8 Material Storage



4.1 Disposal

Disposal of fully cured parts produced are not subject to regulations of any known agency worldwide. VisiJet® support material cartridges may
be disposed of in ordinary office trash.

Uncured part material waste is classified as regulated, and in some areas hazardous, requiring special packaging, transportation, and disposal.
The disposal of partially cured or uncured part material must comply with all local, state, and federal environmental safety regulations. Applicable
part "waste" includes cartridges(empty or full) and waste pans. Any materials used cleaning up uncured part material should be disposed of as
uncured part material.

To find out facility disposal requirements, contact a local waste disposal provider. (Local environmental regulatory agency should have a list of
qualified providers.) You will need to give disposal service provider a copy of the part material MSDS / SDS, and possibly other forms included in
the Appendix of your VisiJet® Material Handling Guide, such as Waste Profile Worksheet and SNUR (Significant New Use Regulation - U.S.
only). A report will be provided, indicating disposal requirements, as well as a quotation for regularly scheduled pickups. If assistance is needed
locating a waste disposal provider, or completing a waste disposal form, contact local 3D Systems Technical Support Hotline.

3D Systems assumes no liability or responsibility for proper disposal of uncured part material. Proper disposal of uncured part material is the sole
responsibility of the user.



4.2 Health Hazards

Health Hazards
Uncured VisiJet® part material is a sensitizer. Skin or eye irritation could occur when exposed to the chemical composition of the

material.
ny chemical may exert harmful effects if contacts or enters the body. VisiJet® part material is a sensitizer and irritant.

Skin Sensitization

ICAUTION: Uncured VisiJet® part material is a sensitizer. Skin or eye irritation could occur when exposed to the chemical composition
of the material.

Uncured material is a sensitizer, and can cause allergic reactions if contacts skin without protective gloves. Refer to personal protection
equipment for more information. To avoid sensitization, do not allow uncured material to contact skin. Consult the MSDS for specific information
about the sensitization potential.

Inhalation

Under normal operation, inhalation is not an expected route of entry.

Ingestion

CAUTION: Uncured VisiJet® part material is toxic if ingested.

Uncured material is toxic if ingested. Uncured material must not be present where food and drink are stored, prepared, or consumed and not
ingested. After handling materials, wash hands with soap and water before consuming or preparing food.

Handling Finished Parts

Finished (cured) parts can be handled or disposed of the same as standard household plastic products. VisiJet® parts are not recyclable.
VisiJet® materials are not intended for, and cannot be used for medical implant, or food or drink handling applications.

Exposure control

The printer has a variety of built-in engineering controls which are designed to prevent operator exposure. Do not try to change or disable these
controls.

Hygienic Practices

Appropriate hygienic practices should be followed, including washing with soap and water before meals, breaks, smoking, applying cosmetics,
using toilet facilities, and after work.

Employees should be alerted to the need to clean and rinse off any contacted surface promptly in order to prevent further contamination.
Ensure a convenient washroom location is provided with access to s‘%p, water, and disposable paper towels.



4.3 Material Handling

Emergency (MSDS)
Chemtrec USA (800) 424-9300; Europe +1-703-527-3887

Packaging Inspection
The VisiJet® material cartridge are packaged in shipping cartons. Upon receipt of material shipments, inspect cardboard carton exterior for signs

of damage and leakage. If leakage is observed, DO NOT open carton, and contact 3D Systems's Technical Support Hotline. If no leakage is
observed, keep the material cartridge in their cartons and store until material is used.

Part Building
If uncured material is observed on the part or platform after build, this is an abnormal condition, and is an indication the printer requires servicing

by 3D Systems or a certified servicing reseller. Assume any liquid or paste-like material is part material. Do not directly touch uncured part
material without protective gloves. Discontinue use of the printer pending service by a 3D Systems Technical Support Representative.
Flammability and Combustibility

Do not expose materials to heat at or above 230°F (110°C), flames, sparks, or any source of ignition. (Though the U.S. Department of
Transportation does not consider VisiJet materials a "flammability hazard," they do classify them “"combustible" based on flash points.) For more
information on VisiJet material flash points and combustibility, see VisiJet® Material Handling and Post Processing Guide.



4.4 Personal Protection Equipment

Exposure to uncured part material may occur when removing and disposing of the waste pan. To prevent
contact, wear chemically resistant protective gloves - nitrile or neoprene gloves are recommended. Do not use
Latex gloves.

In the event of a leak or spill of uncured part material, wear safety glasses with side shields to provide eye
protection

Because of the printer's built in engineering controls, respiratory protection is not necessary during normal
operation. A NIOSH-approved (or equivalent) dust mask is recommended when dry sanding cured material parts.




4.5 Regulatory Information

Support material has no known regulatory requirements.
In the U.S., uncured material is subject to special EPA disposal regulations and record-keeping requirements. "Uncured VisiJet® material"
includes any part material cartridge (empty or full),and waste pan which is partly uncured part material. For complete disposal regulation details,
see Appendix in your Material Handling Guide.
In the U.S., you must keep the following disposal records for five years after the date of disposal:

® The quantity of part material received (new or "virgin").

® The name and address of the shipping location (the "responsible party" - generally your waste disposal service provider).

® The quantity of part material shipped (disposed). For further information, see your Material Handling Guide.

For assistance, contact 3D Systems Technical Support.



4.6 Spilled VisiJet® Material

Spills of material are HIGHLY UNLIKELY, and should NOT occur in normal operation of the printer. If a leak occurs, it is an indication of a serious
printer malfunction.

The first priority is to protect users from inadvertently touching material. Spills of support material can be cleaned without use of protective gear,
and disposed of as office trash. Handling uncured part material requires use of gloves and other personnel protective equipment to ensure no
direct contact with uncured part material. If you don't know which material it is, assume it to be uncured part material, and handle accordingly -
with the recommended personal protective equipment.

Promptly remove spilled material, dispose of waste material, and cleanup materials per local regulatory requirements. Discontinue use of the
printer, and contact 3D Systems Technical Support for a service visit to determine and repair the source of leakage.

Small spills of uncured liquid part material can be cleaned up using disposable towels, non-reusable rags, or absorbing materials such as
sawdust, clay, diatomaceous earth, or activated charcoal. If spilled material is hot (liquid), wait until cools and gels before wiping up. After wiping
up the spill, wipe surface with denatured or isopropyl alcohol and clean thoroughly with soap and water.

Consider avoiding placement of the printer over carpeting, or consider use of barriers to avoid the possibility of carpet damage if spills were to
occeur.

Advise service provider involved, of the spilled material, and provide MSDS and other material information prior to contact with the material.
Advise them of disposal requirements for part material and clean-up products if part material (uncured) is the spilled material. Use of heat above
65°C (149°F) may prove helpful in removing spilled part material from carpet.

Tools contaminated with part material should be cleaned prior to reuse. Solvents such as denatured alcohol or Iso-Propyl Alcohol (IPA), are
normally required to clean equipment and tools. Wash with soap and water to remove any traces of excess part material or solvent. Contact
solvent suppliers for information on proper handling of solvents if used for clean-up.



4.7 Waste Removal

. CAUTION: Uncured part material is a sensitizer. Skin or eye irritation could occur when exposed to the chemical composition of the
material.

Wear protective gloves before removing any waste product from the printer. Be careful not to spill, drop, or expose others to these materials -
particularly part material or waste pan. Dispose of all waste material appropriately per local regulatory requirements.

Dispose of waste pan (if it is not reusable) containing both support and uncured part material. Replace the wastepan evertime or reuse pan if the
pan is reusable.



4.8 Material Storage

BUILD MATERIAL

Shelf life for VisiJet Build Materials with the exception of HiCast &
ProWax - 2 yr

Shelf life for VisiJet HiCast & ProWax - 5 yr

Climate - Cool, dry area with adequate ventilation

Temperature Range - 60°F (16°C) to 80°F (27°C)

Maximum Storage Temp - 95°F (35°C)

Environmental Conditions - No direct sunlight, heat, flames, or UV
energy.

NOTE: For optimal results, keep stored cartons closed and sealed until material cartridges are ready for use.

SUPPORT MATERIAL

Shelf life - 5 yr

Climate - Cool, dry area with adequate ventilation
Temperature Range- 60°F (16°C)to 80°F (27°C)
Maximum Storage Temp - 95°F (35°C)

Environmental Conditions - No direct sunlight, heat, flames, or
UV energy.

visiJet S0
Part number: 23126 - 9o

Net Ingb!: 2Kg ¢ L
Batch: §P111907A
Recertification date: Jul 2016 ‘

Recertification Date

——

iJel Crystal

Always check material "Recertification Date" before use. Do not load material cartridges into printer if cartridge date has expired. When printer

detects an expired cartridge, it aborts the build and rejects the cartridge.

Support Material (two left side
material delivery modules)

Build Material (two right side
material delivery modules)

Support (white) material must be loaded in the left side of material drawer. VisiJet part (black) material cartridges must be loaded in the right
side of material drawer. Before loading cartridges into printer, inspect the cartridges for signs of damage or leakage. Do not load a damaged or

leaking cartridges. Dispose of material cartridge according to local regulations.

Storing a Partially Used Material Cartridges



It is important not to lay material cartridges that are partially used on
their side. Doing so will cause material to seep through the vent cap
and clogging cap. This will cause damage to the material cartridge if
used for a later build.

To store a partially used material cartridges, insert cartridge into a
plastic bag with the vent cap up; place cartridge into its original
shipping carton's sleeves and carton. Do not remove a partially used
Support Bottle from the MDM if the MDM is NOT heating; the material
will solidify and cause a breakage.




05.0 System Requirements

Power Rating

Country Voltage Frequency HAmps (A) Phase Power Cord

USA 100-127 VAC 60 Hz 15A 1 P/N 23417-802-XX
France 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX
Germany 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX
Hong Kong 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX
Italy 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX
Japan 100-127 VAC 60 Hz 15A 1 P/N 23417-802-XX
Switzerland 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX
United Kingdom ' 200-240 VAC 50 Hz 15A 1 P/N 23417-802-XX

If connecting the printer to a 200-240 VAC facility power outlet, connect the power cord (located inside
printer's country kit)to the external transformer. Connect the transformer's power supply to the facility's
outlet.




06.0 Familiarization

The 3-D printer system is a Multi-Jet-Modeling (MJM) line of printers. The solid imaging printer produces plastic prototype parts from 3D solid
Computer-Aided Design (CAD) models and through the printer client software. The parts are generated in a rapid prototyping (RP) environment.
The primary features of the 3-D printer are the user interface, build chamber, material delivery module, and the waste material drawer. The back
of the printer houses the power switch, internet and the power cord connections.

Touchscreen Operator Panel

NOT PRINTING

Waste

Filter Fan Speed
Network Sefup
Syslem Statistics
Software Versions
Configuration Style
Materials

Available Upgrades
Shutdown Modeler
Restart Service
Test Print
Repeat Print

Print Demo

Toggle Chamber Lamp

| 2 PART 2 SUPPORT

+  Status of Printer

» Status of Material

* Yes/Noto confirm an operation or cancel the operation

+  Play to start a build; Pause to momentarily stop the build
and Stop to abort a build.

* Press Main Menu toview the Touchscreen operations.

The operator panelprovide s printer status, and printer
operation functions that are controlled by the operator. Press
the "Main Menu” to view the touch screen of other systems

2A Build chamber 2B Support and part material module
2C Waste drawer and waste pan 2D Operator Panel
Support materials (white bottles) are installed into the two modules on the operations. To selecta operation, use your finger and tap on
leftside of drawer. The part material s (black bottles) are install into the two the function thatyou want the printer to perform.

modules on the right side of drawer,

The three dimensional solid parts built by the printer consist of two materials (support material and part material). The support material is a wax
based material providing adhesion to build platform, as well as, providing material used to produce supports required to build the model.

The part material used to build the parts is an ultraviolet (UV) curable material. After a layer of material is deposited in the build chamber, the part
is exposed to a UV flashlamp. The UV energy is absorbed by the material converting a liquid part material to a solid polymer. When the build is
complete the part (consisting of the two materials) is adhered to the build platform by means of the support material.

The material delivery module consist of four material cartridge holders; the two left side holders are for the support material (white) cartridges. The
right side of the module are for two part material (black) cartridges. Once materials are heated, the materials are feed to the printhead. Material
waste is generated by two processes; cleaning the printhead array plate and planarization. The cleaning process involves purging jets and wiping
the printhead array plate. Gravity pulls the waste material from the Head Maintenance Station (HMS) trough into the waste umbilical. The
combined waste material is then purged. The printhead cleaning process is invoked automatically prior to test build and parts build.

Support Material (two left side Build Material (two right side
material delivery modules) material delivery modules)

After the build is complete, the platform and the part is then removed from the printer. A secondary operation, known as finishing, is required to
provide a finished/cleaned part. Refer to your ProJet™ Finisher's Guide for more information.






6.1 System Functions

Menus: Menu names and menu

B cii =]
options are capitalized in boldface Llient Manager. 3.0 Medelers

text. Instructions for selecting fBle ¥ew Help
menu options look like this: CAICNE |
"Select Menu>Option." This EJ—EJ—%;I Q@j
means "select (click or highlight) = == =2
the Menu, then select Option on L--%
the menu." add madeler sirmu us-ws-3048
JFor Help, press Fl 3D Systems, Inc.

Operator's Touchscreen Control Panel



NOT PRINTING
2 PART 2 SUPPORT

ONLINE,MENU?

e |
=y
|
[ tain wienu_|

Waste

Filter Fan Speed
Network Setup
System Statistics
Software Versions
Configuration Style
Materials

Available Upgrades
Shutdown Modeler
Restart Service
Test Print

Repeat Print

Print Demo

Toggle Chamber Lamp

Main Control Panel

Printer or Build Status- notifies the state of the printer; error messages;
material bottle quantitiesin use; if interactionis needed by the operator,

Confirm Yes or No to printer'smessage that appears in “Printer or Build Status”

Play: Begins a build or brings printer online
Pause: Stops printing mom entarily to change m aterial bottles or em pty waste drawer.
Press Pause again to resume printing

Stop: aborts a print job

Back Button

Touchscreen Main Menu Functions

Press the back button toreturn to the previousscreen.

Waste Status

Support Waste & Part Waste Categories:
Waste Drains:
Support & Part Needed Categories:

Filter Fan Speed

Fan Mode:User Mode
Low Speed

Medium Speed

High Speed

System Statistics

Machine Total Hours: total hours of printer operation

Machine Build Hours: total hours ofbuild time on the printer

Lamp Cure Hours: total hoursof lamp usage

Part Material Use: Displays number of part m aterial bottle usage
Support Material: Displays number of support material bottle usage

Software Version

Software Version: tells the version of software thatis currently on your
printer.

Date Compile: Therelease date of the current software thatis currently
onh your printer.

Configuration Style

Machine Configuration: “B” is the style of machine thatwas released.

Materials Displays the type of part m aterial that has been used.
Displays the type of support material that has been used.
Available Upgrades Notification of system upgrades or no upgrades available

Shutdown Modeler

Shuts down the printer and returnsto the operator’s panel to continue
printer shutdown.

RestartService

Restarts printer service. When services comesback online, the
touchscreen will refresh.

TestPrint

The testprint file consist of 1 layer strips of m aterials; one strip for
supportmaterial and one strip for part material.

RepeatPrint

Repeats the last completed build thatwas printed.

PrintDemo

Prints an actual part

Toggle Chamber Light

Finger tap to turn chamberlighton and off.




07.0 Printer Setup

To prepare and build part files, connect your PC and printer to the network. For additional information refer to ProJet Facility Requirements
Guide.

Component Type Software Requirements

PC Microsoft ® Windows® 98, Millennium Edition (Me), New Technology (NT) 4 (SP 3+), 2000, XP or Windows 7.

® 7.1 Power on Printer

® 7.2 Install Material Cartridges and Print Platform

® 7.3 Install and Run ProJet™ 3-D Client Software
® 7.3.1 Setting Up E-Malil

® 7.4 Create STL File(s) to Build

® 7.5 Submit a Test Print or Print Demo



7.1 Power on Printer

WARNING: Read and follow safety guidelines in Electrical Safety. Ignoring these guidelines could result in death, bodily injury, or
printer damage due to electrical shock or fire.

CAUTION: Verify printer's rear panel power switch is OFF. Connecting power with switch on can damage printer and cause bodily
injury or death due to sudden, unexpected mechanical motion.

1. Plug printer power cord P/N 23417-802-XX into printer's rear panel socket. Plug power cord into a grounded power outlet.

NOTE: |
A shielded Ethernet
cable is required when |(| POWER
connecting from the HH - SWITCH
modeler to the end
user’s computer. ;
POWER

CORD

2. If 200-240 VAC required, connect power cord to external transformer in kit P/N 23418-801-XX, then plug transformer power cord into a
grounded power outlet.

3. Place switch located at the rear of printer to the ON position.
4. Wait 4 hours for printer to warm up before bringing printer online to start a build job.

NOTE: You can submit jobs while the printer is warming up.



7.2 Install Material Cartridges and Print Platform

Material Cartridges
The printer's material delivery module houses two support material cartridge holders and two part material cartridge holders. The delivery module

is located
below the build chamber.

® The part material cartridges are installed into the two holders located in the right side of drawer.
® The support material cartridges are installed into the two holders located in the left side of drawer.

Support Material (two left side Build Material (two right side
material delivery modules) material delivery modules)
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NOTE: Before handling the part material cartridge, read the Material Safety Data Sheet (MSDS.

After powering on the printer, there is a 15 minute warmup period before the material cartridges can be installed. The user touchscreen
operator's panel will direct you when the printer is warm enough to install material cartridges.

CAUTION: Do not remove a cold material cartridge from the printer that has started the warming stage. Doing so could
cause damage to the material cartridge and the MDM. Wait the required 15 minutes if it is necessary to remove cartridges.

CAUTION: When fully melted hot material cartridges are removed from the MDM, do nor lay the cartridges on the side; the
material will solidify in the vent cap cause the vent to clog. Do not reuse the cartridge in the MDM without turning the
clogged vent cap, 1 1/2 turns. Doing so will cause the cartridge to collapse and may cause damage to the MDM.


http://printin3d.com/3d-printer-materials/projet-3000-5000-3d-printer-materials

Vent sealed
from solidify

material.

Collapsed bottle

CAUTION: Please keep bottles clean to avoid any chemical or particulate contamination of the bottle surface or bottle cap.
Any contamination can be transferred from the bottle to the MDM and cause problems. The MDM must also be kept clean
from chemicals or particulate contamination.

Installing Material Cartridges

1. Unpack cartridges and the MSDS/SDS Sheet from cartons. Save sleeves and material carton to store partially used material cartridges.

2. Using a lint free wipe and IPA, wipe the cartridges on all sides including the handle and the colder cap to ensure that no chemical or
particulate contamination are present before installing them into the MDM.

3. Open material delivery module and install two parts cartridge into the right side of module. Push cartridges down into holder until they are
fully seated.

4. Insert the support material cartridges; ensure they are fully seated into the two left side holders. NOTE: If cartridges are not fully
seated in holders, the drawer will not close.

Removing Material Cartridges

1. Each holder has a a latch located at the front of cartridge holders. To remove cartridges, open drawer and pull latch up; lift cartridge out
of module.

Cleaning MDM Holders

When changing material bottles during printing, molten material may be present in the MDM holder after the bottle is removed. If a large pool of



material is present (latch is submerged and walls of MDM are reached), do not place a clean material bottle into holder. The holder will require
cleaning before inserting a new bottle.

Caution: The MDM holder and molten material will be hot; avoid touching the sides of the holder during the cleaning
process. Wear heat resistant gloves and goggles.

To Clean:

® Insert a lint free cloth to absorb the material in the MDM holder.

® Using a long tool, such as tongs; remove the saturated cloth from the holder and place in a waste bag. Continue to clean the holder until
all material is removed.

® After the holder is clean, ensure there is no debris or lint left inside of holder.

® Dispose of waste material and according to your local codes.

Install Print Platform

Clean platform using Isopropyl Alcohol before installing into printer.

. Open the chamber door.

. Align platform's rear notch into x-carriage's locating tab at the back of carriage (4A).

. Align platform's front notch (4B) front locating tab.

. Slide the red latch release back and insert latch's tab into the print platform's front notch (4C).
. Insert latch into the x-carriage's front loop bracket (4D). Release latch to secure print platform.
. Close the front door and press "Play" on operator's panel to bring the printer ONLINE (4E).

~NoOoUuhAWN R

To remove the platform, push latch back and lift platform from x-carriage.

NOT PRINTING

7_2 PART 2 SUPPORT




7.3 Install and Run ProJet™ 3-D Client Software

® 7.3.1 Setting Up E-Mail
NOTE: Before installing software, ensure network and PC meet Printer Setup requirements.

1. Load the 3-D Modeling Client Software from the USB packaged with the printer accessories kit. An autorun file on the USB will
automatically load when USB is inserted into USB port in the computer. [f installation program does not start when loaded, select and run

Setup.exe from the root directory of the USB.
2. After successfully installing software, select Start from the Program menu and then select >3-D Modeling Client icon. The printer

window appears.

E Client Manager - 3-D Modelers

File ‘Wiew Help

add madeler

3. Power up printer as described in 7.1 Power on Printer. Establish a network connection between printer and PC.

Power
Switch

Ethernet
Connection

4. You can only submit build jobs to printer having icons in the window. To create an icon for a printer, click Add printer icon (or choose
File > Add 3-D printer), the "Add Printer" window appears, prompting to choose the printer's IP address from list of available printers.



E Client Manager - 3-D Modelers

File Yiew Help

|

=,

add modeler

5. Select the IP address for desired printer, click OK. The client software prompts for a printer name. After entering a name, an icon for the
printer appears in the 3-D printer window. Once an icon for a printer exists, click it to add files for a build job, preview a build job, sumit a
build job, or manage a build job in progress.

Add a 3-D Modeler 3

Enter 3-D Modeler IP address:

Available Modelers:

MName l IP Address I Type

L2 E

Refresh | Cancel I

6. After the printer is added, click on the icon in the 3-D printer window or choose File > Open 3-D printer to submit build jobs to the printer,
or manage build jobs in it's queue. If the printer icon has a red lightning bolt, your PC is not communicating with the printer. Jobs cannot
be submitted to the printer until communication is restored.



S5ubmit
[~ Job Mame:; ]
Select Files... ] HemoveFiles 1 Options ... ]
1 Job Scale [%]:
M ame Estents
v] 25
C:5Program Filesh3D Swetem... 3112 #3112 20522 in |
Copies:
ﬁ 1
< | 2 [ Preparation Only

Presview... ] | Subrmit | Caricel I

UHD mode is cumently selected. Click Options to change.

X




7.3.1 Setting Up E-Mail

Note: It is encouraged that you determine what the proper SMTP and DNS server information is before proceeding.

® Press the Main Menu to display the touchscreen.

® Finger tap "Network Setup"

® Once in the "Network Setup" menu, finger tap the "Email
Setup;" the Email Setup touchscreen will display.

® |n the Email Setup Menu, finger tap on the each option using
the keypad. Select Save after setting up the individual
options: SMTP Server Name; SMTP Server Port, Login User
Name; Login Password; Admin Email Address; Use TLS.

® Set up according to your preferred providers SMTP settings
and local DNS settings.

® The last thing you need to do is set your DNS Server. This
can be accessed and changed via the Network Setup Menu.

NOTE: The best way to determine your DNS Server, open a
command window on your local pc and type in the following:
ipconfig /all. Your local DNS Server will be displayed in the
returned list. Enter that value in as your DNS Server using the
keypad.
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Shutdown Modeler
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m Restart Service

Test Print

Repeat Print

Print Demo
Toggle Chamber Lamp

——(—) Email Setup
Network Setup SMTP Server Name:iooooacoccs

SMTP Server Port:0

Login User Name: smithj

Login Password: xcooom
Email on Build Start:1

Email on Build Completion:1
Email on Build Abort:1

Email on Cartridge Low:1

Admin Email Addr: (Admin. email)
User TLS: 0

Send Test Email

Email Setup

SMTP Server Name:xxxxxxx
SMTP Server Port:0

Email on Cartridge Low: 1

Admin Email Addr: (Admin. email)
User TLS: 0

Send Test Email




Suggested Settings for Internal & External SMTP Settings:
IMPORTANT: It is very important that you use the Send Test
Email option when setting up your email. If you are not receiving
emails after setup, please check your Junk Mail before changing
your settings to see if your system email is getting sent to that
location.

Internal SMT

i ® SMTP Server Name: your internal server
® SMTP Server Port:* "00000" or your internal server's
port
® Login User Name:* your server's user name
® Login Password:* your server's password Admin
E-mail address: your email
® Use TLS: N

Google Mail (i.e. Gmail)*

i ® SMTP Server Name: smtp.gmail.com or
74.125.45.109
® SMTP Server Port: 00587 or 00465
® Login User Name: your user name*Login Password:
your passwordAdmin E-mail address:
yourusername@gmail.com
® UseTLS:Y

Hotmail Live

d ® SMTP Server Name: smtp.live.com
® SMTP Server Port: 00587 or 00025
® Login User Name: yourusername@live.com (Must
have "@live.com" after your username)
® Login Password: your password
® Admin E-mail address: yourusername@live.com
® UseTLS:Y

Yahoo! Mail
IMPORTANT: You must be a Yahoo mail plus account subscriber
to use their SMTP Server.
. SMTP Server Name: smtp.mail.yahoo.com
SMTP Server Port: 00465
Login User Name: your user name
Login Password: your password
Admin E-mail Address: yourusername@yahoo.com
Use TLS: Y

NOTE: The external SMTP settings provided here are
suggestions that were verified as working at the time of this
software release. However, these are subject to change if the
provider makes a change. Please verify the settings per your
external SMTP provider if you are experiencing problems
receiving email.

Email Setup

SMTP Server Name:xoooooooox
SMTP Server Port.0

Login User Name: smithj

Login Password: Xxxxxxxxx
Email on Build Start:1

Email on Build Completion:1

Admin Email Addr: (Adniin. email)
User TLS: 0
Send Test Email

Remember to SAVE each
individual settings.






7.4 Create STL File(s) to Build

The printer builds 3-D models from files using industry-standard .STL (STereoLithography) format. Most popular 3-D modeling CAD software
packages can save files in STL format. Sample STL files are in the \3-D Modeling Client\Samples folder.

Click the Submit Icon

Click the Select Files...

Double Click on Sample.stl file

“i. Plastic ProJet - Info
Job | View

Modeler

| End Time

Job Name: | default

Select Files... | Rgmaove Files | Options ...

Select CAD Files

3 aok in: I_@ Samples - - ®memE-

For Help, Sample.stl

|~

Preview.

T |

File name: ISample,stl Open I IV File Preview
Fies of type:  [STL Files ") | Cancel |




7.5 Submit a Test Print or Print Demo

To ensure that the printer is functioning properly, a Test Print is recommended. This print print is provided on the ProJet 3500 hard drive. It
consist of 1 layer strips of materials; one strip for support material and one strip for part material.

The Demo Print is an actual part file that you can use as a test build. Please follow the operation procedure described below.
To Start a Test Print or Print Demo:

® Press Main Menu and tap on Test Print or Print Demo on the touch screen; once selected, it will high-light and then return to the
operator's panel.

In the operator's panel , the message "PLATFORM CLEAR / DOOR CLOSED? " or a message to check the waste drawer will display.
Press Yes if the platform is clear and door is closed, otherwise press No and ensure that platform is installed and the door is closed.

If Yes is selected, the printer will begin printing.

After the print is completed, the message "Remove Print" will display. Open the printer door, and remove the print platform as described
in Step 4, "Print Platform * Installation." For parts post processing instructions, refer to VisiJet® Part Processing User Guide.
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08.0 Operations

This section provides information on Previewing, Saving, Submitting, and Managing jobs through the printer's operator panel menu and 3-D Client
Software. In addition this section describes how to remove the build platform, how to empty the waste drawer and how to shut down the printer.

NOTE Make certain the printer is Off-Line during the job submittal process. Place the printer on-line after the job is submitted.

® 8.10 Shrink Compensation for ProJet VisiJet® Materials
® 8.1 Preview Build Job
® 8.1.10 Undo Zoom

8.1.11 Help Topics
8.1.12 Selected Part Information
8.1.13 Wire Frame Display
8.1.14 Bounding Box Display
8.1.15 Display Support Creation Surface
8.1.15 Shaded Display
8.1.16 Isometric View
8.1.17 View Platform and Parts
8.1.18 View All Parts
8.1.19 Selected Parts
8.1.1 Cad File
8.1.20 Delete
8.1.21 Copy
8.1.22 Mirror
8.1.23 Translate
8.1.24 Rotate
8.1.25 Scale
8.1.26 Align Parts Facings
8.1.26 Scale mm to inch
8.1.27 Scale inch to mm
8.1.28 Undo
8.1.29 Verify
8.1.2 Submit a Build Job
8.1.30 Auto Part Placement
8.1.32 Estimate Build Time
8.1.3 Part Selections, Translation,Rotation
8.1.4 Trackball View
8.1.5 Triangle Selection
8.1.6 De-Select all Triangles
8.1.7 Select all

® 8.1.9 Zoom
8.2 Save a Build Job
8.4 Manage Build Jobs
8.5 Printer Status
8.6 Empty Waste Drawer
8.7 Shutting Down Printer
8.8 Remove Platform

® 8.8.1 Remove Part from Print Platform
® 8.9 3D Printing Batch Submission for Production Environment



8.1 Preview Build Job

Click on theicon to view the functionality of the print preview icons.

¥ Print Preview for 3-D Modeler - 3-D Printer Print Preview

Fle Edt Vew Tocks Help

Bl%| efs == e alel osl BlE6 o6 FlE0|E@|@Iss.5 | ollnle| sl <lelw|wlmo«]
25Kl

For Help, press F1 Uniks: inch. Prolet 5000 30 Systems, Inc.

Preview a build job before submitting.
Preview jobs before submitting them to the printer.

1. Click Preview...button on the Client's Submit dialog box. At least one part must be added for build in the Submit dialog box before able

to preview.
—
Submit IX]
I~ Job Marme: I
Select Files... | Hemove Files I Options ... |
I Job Scale [%]:
M ame Extents
I TI 25
C:AProgram Filesh30 Sestern.. 3112w 3112 w0522 in |
Copies:
=
< il I N Preparation Only
Prewview... | | Subrmit I Cancel |
| IHD mode is cumently zelected. Click Optionz to change.




2. Highlight a Job Name in printer's Info window, click Preview button or choose Job > Preview.

When the preview window opens, STL files can be added and removed, parts can be changed, rearranged, and submitted. The modified jobs can
be sent directly to the printer's queue.



8.1.1 Cad File

To add a part,
click the Add Part
button or select 3
File, Add a STL

or CTL File. The
system displays a
file browser dialog
box which you can
use to select one
or more parts.
Select open on the
dialog box to add
part to the print

i SAOHES
preview platform. e S LT

&8 opElEl ninl alel eisl oS soEscEEEaRe oninle sielvisiels s

akde,_ol_tad 8_CLUIT

TLFien " 2f

RS R, e S

Click here to return to Print Preview Browser.



8.1.2 Submit a Build Job

1. Click on printer's icon in the printer's window. The printer's Info window opens.

B Client Manager - 3-D Modelers
File Wew Help

v/ % /5| @
= =

add miodeler zimu

uz-wg-3048

For Help, press F1 30 Systems, Inc, 7

2. In printer's Info window, click Submit to open Submit dialog box.

‘& ProJet - Info

File Modeler Job View Help
Submit a
EE - || olelele| o
| Ext Job Status Buid Time | Start Time End Time
johnsond(@us-ws-0880-0011 Printing 11:16 Tue, Mar 18, 2008 02:51 PM Wed, Mar 19, 2008 03:43
pursleypl@us-ws-0717-0007 Previewing 03:00
< | >
Submit & job \"ProJet": Printing Tue, Mar 18, 2008 04:33:46 PM \ProJet HD 3000 3D

3. Click Select Files on the Submit dialog box to add one or more parts to the build job. NOTE: More than one STL file can be selected
at atime. In Select CAD Files dialog box, hold down the Ctrl key and click on several STL files. Add parts in Preview window. After you
have added at least one STL file, use Preview window to view build jobs in three dimensions, and to add more STL files if desired.

Sample STL files are in the \3-D Modeling Client\Samplesfolder.
Click the Submit Icon

Click the Select Files...

Double Click on Sample.stl file

“i Plastic ProJet - Info

| End Time

g | Options ...

< ook in: Ib Samples j - ek B

For Help,

|~

File name: ISampIe,slI Open I IV File Preview
Files of type:  |STL Files ("t ~| Cancel |
% |

4. Browse files in Select CAD files window. When files are selected, file names appear in build job parts list of Submit dialog box.

5. Click Options...button on Submit dialog box. The Default Job Options dialog box appears.



Default Job Options E]

; i Shiink. Comp [%]
[ SaveVerfied STL file

Eal .00
¥ Enable Part Placement

[ Saveldob 5 0.00
[ Quick Build Orientation - |- .00

™ Shareable s
; doi Itz
¥ Ulra High Definition [UHD) & Inch
BuildStyle: I i Columis J ™ mm

] | Feset ‘ Cancel

6. Change or reset values, such as Build Style, Shrink Comp (%), and Units. (See "Default Job Options Dialog Box" in the 3-D Modeling
Client online Help for job options definitions.)

Parts shrink in X and Y. The degree of shrinkage depends on part geometry. To improve part accuracy, apply the X, Y, and Z Shrink
Comp (%) values then measure your parts and refine these values. Refer to 8.10 Shrink Compensation for ProJet VisiJet® Materials.

7. Click Preview on Submit dialog box. If the file you are trying to preview is beyond the threshold of a certain file size, the system will
automatically access the Bounding Box Display feature. See Section 8.1 Preview Build Job for details.

Submit X

[ Job Marme: ]
Select Files... I ernoye Files ] Dptionsz ... I
] Job Scale [%]:
M ame Estents
v] 25

C:APrograrm Filesh30 Sestern.. 3112w 31120522 iR |
Copies:
=i 1
=1

< | - Preparation Only

Presigw. .. I | Subrnit | Cancel I
UHD mode is n::'ur'rentl_i,l selected. Click I':Ii:n'tiEn-ns' ta E'hangie.-

8. Manipulate parts interactively in the Preview window's virtual printer 3-D build workspace.



“¥ pursleyp@us-ws-0717-0001 - 3-D Modeler Preview E|[X|
File Edit View Tools Help

Bl 6fS W= Bl A% 08| Glslnlelele €lelv|v]e|D|n &

o | ||B|E|a B ® T ale

L)
&

For Help, press F1 Prolet UHD \3D Systems, Inc. /|

9. If required, resize all parts in build job by the same scale factor, enter a Job Scale % in the Submit dialog box before clicking Submit. To
resize some of the parts of your job, use Edit > Scale in Preview. (See the topic "Previewing Print Jobs > Scaling Parts" in your ProJet
Client online Help for instructions.)

NOTE Applying Job Scale % (or scale percentage(s) using Edit > Scale in Preview)) is different than applying Shrink Comp % values
in the Default Job Options dialog box. Applying scale percentages changes "nominal” part dimensions in the STL file(s).
Applying Shrink Comp percentages does not change nominal part dimensions in the STL file(s). Rather, Shrink Comp adjusts
for expected shrinkage during the build so the actual final part dimensions more closely match the nominal dimensions.

Scale Selected Parts

¥ |zometric Scale | 100 =

® ¥ z
| 100 | 100 | 100 %

Maotice: Input zcale value relative ta the arignal mode.

10. See Section 8.1 Preview Build Job.

11. Click Submit on Submit dialog box if you did not preview the job, or click Submit toolbar button in the Preview window if you did preview
the job.



Submit

[ Job Mame: I

Select Files... | FE-‘-':-;'-fE*FEi:--;i Options ... I

Job Scale [%]:

M ame ! E stents D_""
2128312820522 00 125

C:%Program Filesh3D System...

Copies:
=
I & Preparation Only

Presview... i | Subrmit I Caricel ]

[

[ IHD mode ijsnl-:urrentl_l,l zelected. Click Options to change.

Both the 3-D Modeling Client and Print Preview now check to make sure that the maximum allowable accumulated build file size on the
machine is not exceeded during job submission. The maximum threshold for job submission is roughly two gigabytes or 40,000,000
triangles. If a User attempts to submit a job to the build queue that exceeds this threshold, the following message will be displayed.

Submit Job

The total number of triangles is 40982940 and over the modeler's capabiliby (40000000 triangles). Job can not be submitted

12. The build job submitted will be built when printer is ready unless:
® |tis OFFLINE, in which case press the Play button on the operator's control panel.
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® |t does not have a clean build platform installed; install clean one and press ONLINE.
® The Preparation Only option in the Submit dialog box was checked. This causes the printer to wait until the build job was
confirmed before building --- enabling you to change the job in the Preview window again before confirming.

NOTE See "Checking Printer Status" and "Confirming Build Jobs" in the online Help for more information.

13. When the Operator panel shows PLATFORM EMPTY? Y/N, verify platform is clean and free of debris. If required, press NO and remove
build platform from the printer to replace.

NOTE:  Prior to installing a build platform verify both sides of platform and x-carriage mating surface are free and clear of debris.

14. Open chamber door and carefully position rear of clean platform onto X-carriage under tab on back of X-carriage.
\

15. Lower platform onto X-carriage. While holding onto platform tabs close latch. Ensure latch clicks.

16. Close chamber door and press Plat to bring the printer online. When the Operator panel LCD shows PLATFORM EMPTY? Y/N, press
YES. If the display shows please empty waste or next build will exceed waste capacity, open the waste drawer and dispose of waste
material.

17. Close waste drawer. The job starts automatically.



Waste Drawer

NOTE | If the display shows WAITING FOR JOB, no jobs are in the printer's queue. Go back to Step 2 and submit a build job to the
queue. Once in the queue, the job starts automatically.

18. Refer to Manage build jobs for additional information.



8.1.3 Part Selections, Translation,Rotation

Use part selection,
translate, rotate
tool to move parts
in specified X and
Y axis as well as
in the XY
coordinates. The
parts must be
viewed in top,
bottom left or right
to manipulate
them.

Fils Edb View Tool el "
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8.1.4 Trackball View

Use the trackball
view to change the

platform viewing mm_m
area. Normal e Edt View Took Help

18 8J5 =15 nin) al% 8lsl blE[0 eTgETERFRRR] alenaie) sitlvviekol snEp

dragging (with the
left mouse button
pressed down)
rotates the viewing
area. When using
the right mouse
button, the build
envelope can be
dragged around
within the viewing
area.




8.1.5 Triangle Selection

Use the triangle
selection to select
one or more
individual
triangular facets
on parts. After you
select more than
one facet, press
the shift key while
clicking. If you
select more than
one faceton a
single part, that
part will not be
reoriented when
you use the align
facing button.
You may find it
easier to select
specific triangles if
viewing parts as
wireframe. The
2-D views may
also help find the
triangles that you
want to select.




8.1.6 De-Select all Triangles

Use the de-select

all triangles to

de-select the L= 3-DModeler BARERREVEW. e = X
triangular facets Fia Edt Vew Took Hep

on parts. B(%) 0/50% 5| BlR A% 96 006 SFISIESIEE SRR GEIRIGISI <l6|¥|vieola] bk

Linits: inch [Proget 50 3000 Shde: HO 30 Systims, Inc.



8.1.7 Select all

When using the
De-Select all icon,
all parts on the
platform will
become stationary.

=+ - 3.0 Modeler Print Presdew ] |&®
Fis Bt View Took Help
i) B0 5 RiE AN 8 0l 0 ¢D FEAtIRrERRRE] Clsisiec slelsv]sds i
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8.1.9 Zoom

Zoom in on the
parts incrementally
to enlarge until
they fill the viewing
area. Click and
hold the mouse
button until and
drag across the
area that you wish
to zoom in on for
part detail.

RS/ G S SR B0 S5 A GIFPPRRE DEING S el Hvtas S




8.1.10 Undo Zoom
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8.1.11 Help Topics

When selecting
the help topics
icon, 3DS Central
log in page will
automatically
display asking for
your User Name
and Password.
After typing in the
log in information,
select "Remember
my login on this
computer" and
then click on "Log
In". The ProJet
3500 Documents
will become
available to help in
searching for
information in
question.

Flease Login to access

tha site and Tohep,
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8.1.12 Selected Part Information

Click on the B|%| KO || BR|EG] WA[R WO | 3| SO O O O B B
selected part o e o) e e O L ) RS N o e
information icon to
display the part's
information dialog ; -+
File; [1.68 6 st "1
with details about . l
the currently Length Units
selected part. Surlace Anes (30 units) 85587

Part Volame{cubec units): 1216
Wisight Units Ib
‘Weaght af Part 0287183
Weight of Suppoet 0.336126
Part Carndges Estmaled: 1
Suppod Cartridges Esmoted 1
Humnber of Tnangles 136178

Extants Informaion
Min Max Teaal
0 STE916 576916

0034558 691616 GEBISE
o 12967 118676

il Flatiarm Extents
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8.1.13 Wire Frame Display

Using a wire frame allows Fite Edit View Tools Help
visualization of the underlying design Bls 6l 55 B 4% @n] 18 &0]eSE SIS SR e

structure of a part. alznlaleln] <lelsvivlol | wEre




8.1.14 Bounding Box Display

T AL YRCE sl TR

T imerorel | ela ef5 5151 Bl W Oi8] OfF 814G SISIGISIBIGIAIRLS.
geometric figure ] <

consisting of six o0l el Slel#v]lpls] ) e
rectangular plane
faces, each set at
right angles to the
four sides adjacent
toit.
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8.1.15 Display Support Creation Surface

Select the part and click | le Edit View Tools Help

on the Display Support | ji4,| @[5 || 25| A% @8] BlF[6[e IEIEIPIEISIF ass.|

Creation Surface to
identify where the sl0lclelc slelwvie|Dls | SlElEa
supports are placed on
the part. The support
structure will be
high-lighted green. Use
the trackball to rotate the
platform to view
structure. Note: The
support structures are
high-lighted in green.




8.1.15 Shaded Display

Using a Shaded Display e Edit View Tool Help

allows visualization of the %) &f5 35 Rl A% Gl 81506 ¢8|S0 SEIFIFIRERE
solid design structure of a o e S s A s s R T

part. When using the
wireframe display, toggle
back to the Shaded Display to
view the solid design.

Units inch Prodet HID 3000 151
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8.1.16 Isometric View

View parts on the platform in 3-D isometric or view the
top, bottom, front, back, left, and right using the
viewpoint buttons. It scales and orients the display to

the standard view point from one corner of the build
envelope.

Isometric View

Top View

Bottom View

S5

gl
W
i

Front View Back View

Right View




8.1.17 View Platform and Parts

This predefined view zooms the view |7 .., rres

to include the entire build envelope wih) 1€ o515 n) ala] o) o oleliilS clelE el
and all the parts on the platform. nlminialeln) slelAviniols il




8.1.18 View All Parts

View all parts display the parts, and enlarges them as

much as possible omitting empty portions of the build
envelope.

Fie EQIL VIEW 100IS Help
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8.1.19 Selected Parts

View selected parts enlarges the
selected parts until they fill the
viewing area. The selected part is
yellow high-lighted.




8.1.20 Delete

To delete a part / parts from the platform, oo vy ey Tem

select a part using the "Select part" or [s] o SI=| =] R[5 8% Ol SIFI0 #5 FI5|0|&|6E|5|55 8
"Select all" tool and then click the delete icon = |22[00[ & @{oa] «| | #fw [ mlaf=] &lmEio

to delete the selected part / parts.




8.1.21 Copy

To copy a part, select part and click on
the copy icon. A dialog box will appear
asking for the number of copies and the
distance between them. Enter the number
of copies and distance, click Apply to
generate the copies.

be Edit View Took Help
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8.1.22 Mirror

T U WEW rwss e

To create a mirror image of one or =
several parts, select the parts and click %) € S5 pin)

the mirror icon; the dialog box will
appear. Choose an axis around which
to mirror the part, and a separation
distance, click Apply.
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8.1.23 Translate

Use the translate
part dialog box to
move parts by
entering inch
values. The dialog
box allows relative
movement (parts
are moved from
their current
location in
specified X and Y
axis) as well as
absolute (parts are
specified in the
specified X,Y
coordinates).
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Units:  inch
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8.1.24 Rotate

Select the partto rotate | %/ [& &% | 5| &% @s| glas
and click on the rotate B A RS R e e e e M [
icon. Use the dialog box - o ———
to rotate the degree
amount in Y,X,Z
directions in the
maximum of 180°.




8.1.25 Scale

Parts can be scaled by percentages, eith ¢ Fd® Vew Teok el

isometric meaning all axes get the same %] [8 G151 Bl A% O[6] 0|00 &[5 200 @le g s w)
scale factor or differently in each axis. Bel2tlonin | @lon] <[f]e vl SlEE e
Select one or several parts and click on the
scale icon; the dialog box appears. Enter a
scale value, then click the apply. Scale
values are absolute. A value of 100%
always returns the object to its original
scale; 200% is always twice the size of the
original.
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8.1.26 Align Parts Facings

Instead of | e e R eV LT [l i e [N N N
o e ) e R L S e S T A

manually rotating
parts, you can
select a triangle on
the part and have
the system align
the part until the
selected triangle
faces a desired
direction: up,
down, the X-Z axis
or the Y-Z axis.
Select a triangle
using the triangle
selection tool, the
align facing
buttons become
enable. Click the
align part icons to
rotate the part until
the selected
triangle faces the
selected direction.
Triangles can be
selected on
several parts
before clicking an
align Parts Facing
icons so that all
parts can be
aligned together.




8.1.26 Scale mm to inch

ggiﬁaa;‘gse‘(‘j”f'::g" sl @ SlE)E Rl Al 06| elsle g6 Slolselen s |

millimeters to inch | | Ge[28]00| G @08 €| ]| %] &[5/

by dividing 25.4
into the part
measurement.
Select the part and
click Scale to inch
icon. A dialog box
will ask if you want
to proceed with
the modifications;
select "Yes" to
proceed with the
parts unit changes
or select "No" to
discontinue.

Al the modifications done to the selected files will be applied.
Proceaed?




8.1.27 Scale inch to mm

ggiﬁaa;‘gse‘(‘j”f'::g" sl @ SlE)E Rl Al 06| elsle g6 Slolselen s |

inch to millimeters | | Ge[28]00| G @08 €| ]| W] ||| &5/

by multiplying 25.4
to the part
measurement.
Select the part and
click Scale inch to
mm icon. A dialog
box will ask if you
want to proceed
with the
modifications;
select "Yes" to
proceed with the
parts unit changes
or select "No" to
discontinue.

Al the modifications done to the selected files will be applied.
Proceaed?




8.1.28 Undo

Click the undo
icon to bring part
back to its
previous state
after changes
have been made.

&) [@ ol% /5] nlsl Al 018]
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8.1.29 Verify

Verification detects

and fixes problems %] & Si==E ninl alw ekl 8lE(ae 5 &\0/EE)E]8 68

inthe STL. Also | HESl0le|@lo] <|¢|v|v|w|d|s| &/alE]e|
individual STL part
can be verified by

selecting it and

then clicking the
Verify icon.

S

Verify Success

| N

2

The selected parts have been verified successfully.

OK I




8.1.30 Auto Part Placement

This tool arranges parts for
optimum build speed. Selectthe | #. [& &5 | Ml e @ln| o6 S5 @l @6 G n gl
parts and click on auto place. The | 2 \mje efeg] «|¢]we|wlala] wlElEo

parts will automatically arrange in

the build envelope.

Edit Weew Tools Heip




8.1.32 Estimate Build Time

[ ] Prird Preweew for 3-0 Modeter - 3-0 Modle
Fie Edit View Took Help

Click on the estimate build time
icon to estimate the time it will

take to build the part. ﬂﬂmiummgﬁl Mﬁf’: | |
alzlnlelela] <lslsvizils cnEe

ey hdite, pretd FL Uit inch Prdet MO 3000 Styie: HO




8.2 Save a Build Job

Prepare and save build job(s) on your PC. Later, submit the job, skipping preparation steps. A saved job is specific to a single PC and can only

be built or deleted from that PC.

1. Click a printer's icon in 3-D printer's window to open printer's Info window.

B client Manager - 3-D Modelers

File View Help
Open 3-D Modeler

Chrl4+0

Chrl+4

y Modeler  Chrl4D E[E‘ % %
eate Shortcut ic projet invision invsion2 invision3
Exit

Add a new 3-D Modeler

a*

projet2

E['El ks

invisiond

v

3D Systems, Inc. -

File Modeler  Job  Wies

Help

| End Time

[~ Job Mame: I defaul

Select Files... I Remove Files I Options ...

Select CAD Files

< Loak in: IE} Samples

= - E ek E

For Help,

= |Sample. stl

|~

File name: ISampIe.stI

Open I

Files of type: ISTL Files [*stl)

2. Select Job name to be saved.

LI Cancel

¥ File Preview

3. Choose Job > Default Options.

Default Job Options 3|
OGS - ShekCowrd
[ Save Verfied STL file

K i v! 0.00
¥ Enable Part Placement

[ Savelob ¥ Ij' 0.00
[ Quick Build Qrientation > |- 0.00
[~ Shareabls T

3 s — Urits—
v
¥ Ulra High Definition [UHD] i
BuildSyle; I'-;ert:::-'_ci Colurnits _ﬂ " mm
aF. I Reset | Cancel

4. In the Default Job Options, select Save Job, then click OK.




NOTE: Jobs to printer queue cannot be saved unless Save Job was selected. When a build job with the Save Job option enabled
reaches Pending status, another job (with the suffix "_s") is added to the queue. For more information see Saving, Repeat,
and Confirming Build Jobs in your ProJet Client online Help for more information.



8.4 Manage Build Jobs

The client software will not send build jobs to the printer until job confirmed by selecting Preparation Only checkbox on Submit dialog box or
resubmit a saved build job.

Submit E3

[ Job Mame: ] default:

Select Files... ] HemoveFiles 1 Options ... ]

Job Scale [%]:

M ame 1 Extents ]}]—_ﬁﬁ

Copies:

[
[
<]
[11]
am)
@
o
=
=
]
=

Prewisin Skt Carizel I

UHD mode is cumently selected. Click Options to change.

1. Click printer's icon in client software to open printer's Info window.

B client Manager - 3-D Modelers
File Wew Help

=

add modeler zimu uz-wz-3048

Far Help, press F1 30 Svstems, Inc.

2. Select build job with Job Status of Needs Confirm or Saved.

3. Click Confirm button or choose Job > Confirm located on the tool bar of the printer window.



% ProJet - Info

Fle Modeler Job View Help

(¢ 5|&/% o/elele| @

Jab Name | Job Status | Buld Time | Start Time | End Time

johnsond@us-ws-0880-0011 Printing 10:59 Tue, Mar 18, 2008 0251 PM ‘Wed, Mar 19, 2008 0349
purslepp@us-ws-0717-0007 Previewing 000 e

¢ r ?
|For Help, press F1 "ProJet"; Printing \Tue, Mar 18, 2008 04:50:42 PM ProJet HD 3000 \SD

4. Click Yes. Job is sent to printer as soon as it's available.

' "-q,, Do wou want bo submit oliverm@us-ws-3048-0006 Lo projet 7
L

A Needs Confirm build job status immediately changes to Pending when confirmed.

NOTE Confirming saved jobs generates a Pending build job whose name lacks the "_s" suffix. However, saved jobs remain in the queue.



8.5 Printer Status

To view the printer's status, observe the operator's control panel for elapsed build time, build time remaining, material information, job status,
name, time remaining on build, error messages, and system statistics.

NOT PRINTING
2 PART 2 SUPPORT

OMNLIME MENUI?



8.6 Empty Waste Drawer

Harmful Irritant

Wear Gloves

Personal protection equipment is required before opening waste drawer. Follow all material handling and disposal guidelines. Always follow
MSDS guidelines and local regulations regarding handling and disposal of regulated materials. Keep disposal records if local law requires.

Note: During operation, the user interface will prompt you to check the waste drawer periodically to see if waste pan needs to be empty.

ProJet 3500 comes with a
waste pan kit that
includes six (6) waste
pans and six (6) waste
bags. To order more
waste pans and bags,
please refer to the ProJet
3500 Parts Locator and
locate the Waste Pan Kit
part number in the spare
parts numerical listing.

1. Press "Pause" on the
operator's panel. When
pause is completed, open | NOTPRINTING

waste drawer. | 2PART 2SUPPORT

ONLINE MENU?

[ No) "_"

[Py | Pousel St

2. Open waste drawer.

Waste Drawer




3. Remove waste pan and

dispose waste pan in one . ®* Remove
of two methods: contents
by
e ® Place scraping
waste pan the block
and of waste
contents out from
in the bag pan and
after every putting the
build. waste in
Dispose the bag.
of waste The waste
bag pan can
according be reused
to your v 4 until it no
local longer
codes. holds its
shape.
Dispose
of waste
bag
according
to your
local
codes.

4. Install new or reused
waste pan in the back right
corner of waste drawer.

5. Close waste drawer and
press Pause to resume
build. | NOTPRINTING

‘ 2PART 2 SUPPORT

ONLINE MENU?

[ho




8.7 Shutting Down Printer

WARNING: Switching off or disconnecting the printer's power without going through a shutdown process can severely
damage the printer. Always perform shutdown procedures before switching off printer's power unless power must be
disconnected immediately for safety reasons.

The printer can take several hours to warm up after being shutdown and switched off. Before shutdown and switching off, verify that the need to
build parts is not a factor.

Mode
Standby 15 Min.
Conserve = 25 Min.

Initial Pwr = 90 Min.
Up

NOTE: It is recommended to leave your printer in either standby or conserve mode instead of shutting down if the printer is to be used
within 7 to 10 days of last build.

After printer is idle 2 hours or 72 hours, it enters Standby or Conserve mode, respectively. In these energy-saving states, the printer's heaters are
partially cooled and many other components are disabled. The heaters are cooler in Conserve mode more than Standby mode. It takes less time
for the printer to warm up from Standby or Conserve mode than it does from full shutdown/power off. Warming up from Conserve mode takes
more time than from Standby.

NOTE To increase or decrease wait time before printer enters Standby mode or Conserve mode, contact 3D Systems Technical Support.

1. Verify printer is not building.
2. Press Main Menu, and tap on "Shutdown Modeler " on the touchscreen panel. Once selected, it will high-light and then return to the
operator's panel.

NOT PRINTING

2 PART 2 SUPPORT 2 PART 2 SUPPORT
Filter Fan Speed
- Network Setup
ONLINE,MENU? System Statistics OK TO POWER OFF 00¢

Software Versions e
Configuration Style | No |
Materials

Available Upgrades .
Shutdown Modeler4m
Restart Service

Test Print
Repeat Print

Print Demo

Toggle Chamber Lamp

3. Press YES twice.
4. When the display shows OK TO POWER OFF XXX, press the power switch on the rear panel.






8.8 Remove Platform

When operator panel display shows <job_name> Remove Print; open chamber door.

1. Hold X-carriage, in place using the loop at the front of carriage.
2. Open latch securing build platform by pressing inward and releasing.
3. Lift up print platform and pull out, then install a clean platform or close chamber door.

Carriage
Loop




8.8.1 Remove Part from Print Platform

Remove print platform from printer. refer to 7.2 Install Material Cartridges and Print Platform

® Place warm platform of parts in a freezer for a few minutes. As the parts and platform cool, they contract at different rates and separate.
® Alternatively, the parts can be mechanically separated from the build platform by force using a tool such as a thin blade.



8.9 3D Printing Batch Submission for Production Environment

The printer batch processor allows users to prepare/send jobs and inquire job status for multiple printers across networks without using 3D
Accelerator Client software, which requires human interactions. It is compatible with various 3D Systems' supported 3D Printers, including ProJet,
InVision, and ThermoJet.

The ModelerBatch.exe application reads the job parameters from the given parameter file (.ini file), then prepares, packs and sends the jobs to a
designated printer. The ModelerStatus.exe application allows the user to inquire the job status on a designated printer for both current and
previous jobs including "printing", "pending", "completed”, and "aborted".

Printer Batch Processing

Setting Job Parameters via INI File

Before running the ModelerBatch.exe, a text file must be created that specifies the desired parameters for the pending job. See example below:

B sample.ini - Motepad EHEI@
Ble Edt Formab  Wew Help

[10B PROPERTIES]

IP Address = 000,000, 000, 000
Wumber of Parts = 4

Partl =C: \stIModel“pPartl.st]
Part2 =C:“stiModelwpPart2.stl
Part3 =C:“stIModel“pPart3.st]
partd =C:“stIMmodelwpPartd.st]
AUtO Part Placement = NO

Max Extent X = 70.00
sharable = yes

quick Build = No

pual Mode UHD=Yes

verify = nND

shrink Factor x = 0

shrink Factor v = 0
Shrink Factor Z = 0
Support Style = Standard

Units = mm

lob sScale %= 100.00
WNumber of Copies = 1
cave Job = MO

save verified sTL MO

[10B PREPARE]
wait Timeout=3600
Display Error Msg = ves

L1, Cod

All the job parameters are categorized into two sections:

® Job Properties
® Job Prepare

The table below provides a description of the ModelerBatch INI parameters.

Parameter Default Description Section
Name Value Name
IP Address N/A IP address of the designated printer, e.g., 192.168.0.2 or 192.168.000.002 Job

Properties



Number of
Parts

Part#

Auto Part
Placement

Max Extent X

Sharable

Quick Build

Dual Mode
UHD

Verify

Shrink Factor X
Shrink Factor Y
Shrink Factor Z

Supports Style

Units

Job Scale %
Number of
Copies

Save Job

Save Verified
STL

Wait Timeout

Display Error
Message

N/A

No

dPlatExtX

No

No

Yes

No

0.0

Standard

Inch

100.0

No

No

3600

Yes

Running the application

Total number of parts in the job

Full path and name of the STL/CTL file. # must be replaced with numbers which start from 1,

e.g., Partl, Part2, and Part3 ... The total number of parts must be consistent with the total number
of parts.

If a file name is one of:

Modeler_Verification_Strip.STL

Modeler_Verification_Strip_InVision.STL

Modeler_Verification_Strip_ProJet.STL

Modeler_Verification_Strip_ProJetCPX.STL

...then the file is the verficiation strip.

Valid values are "Yes" or "No".

If Yes, the Batch Processor performs auto part placement.

If No, the parts will not be auto placed.

However, the users should ensure the part sizes and positions are appropriate.

Max job volume X extent, which is used to position the verification strip for optimal build speed.
The default value is the max platform X extent, which is 6 inches for ProJet 0000 in high resolution
mode.

Valid values are "Yes" or "No", which specify if the print job will be shared with other jobs in the
printer.
The print job will not be shared if this field is absent.

Valid values are "Yes" or "No", which denote whether the parts should be oriented in the printer to
save print time.
Quick build part placement will not be performed if this field is absent.

Valid values are "Yes" or "No", which specify if ultra high resolution (UHD) mode is used to build the
parts.

UHD will be used if this field is absent.

This option is only valid for the printers with dual-mode capability.

Valid values are "Yes" or "No", which specify if verify needs to be performed on the parts.
Verify will not be performed if this field is absent.

The corresponding shrinkage compensation factors desired in percentage.
These fields will default to O if absent, which means no shrinkage compensation is added.

This key defines the type of supports desired.
The Standard supports type will be used if this field is absent.
Valid values are Standard, Vertical Columns, Universal Std, or Universal HiRes.

This key defines the units for the job.
The units will default to Inch if this field is absent.
Valid values are Inch or mm.

The key indicates the scaling desired for the print job.
The scale will default to 100% if this field is absent.

This key defines the number of copies of the specified parts in the list.
The default is to created one copy for each part in the job.

The key is used to specify whether the job is to be saved in addition to printing.
The job will not be saved if this field is absent.
Valid values are Yes or No.

The key is used to specify whether the verified STL is to be saved in the same folder of the STL file
using the name STLFileName_v.stl.
The verified STL will not be saved if this field is absent. Valid values are Yes or No.

The key denotes the allowed wait time to send jobs from the client to the printer.

The wait time depends on the client computer and network speeds.

If the wait is more than the allowed wait timeout, the ModelerBatch.exe will be aborted.
The default allowed wait timeout is 3600 seconds (or 60 minutes).

The key denotes whether to display an error message dialog (i.e. - Pop-up message) if any error
happens.

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Properties

Job
Prepare

Job
Prepare



The ModelerBatch.exe application can be invoked from command line or program. The command line format is as follows:
RootDir\bin\ModelerBatch.exe IniFile ReportFile

Descriptions:
RootDir - the installation folder of the ProJet client, which can be obtained from the registry by using:

Key = "HKEY_LOCAL_MACHINE\SOFTWARE\3D Systems\3D Modeling Accelerator"
Name= "RootDir"

ReportFile - returns a report to a specified file on the job submission

Note: If a filename is not specified for the report file, the data will be written to a default file named ReportFile.txt. This file will be overwritten every
time the modelerbatch.exe or modelerstatus.exe applications are run without a report file specified

The DOS window show below is an example of running the ModelerBatch.exe via command window.

AWINDOWS\system32\cmd

Microsoft Windows HP nb5.1.
{C» Copyright 1985-208 icrosoft Corp.

G:\>C:\"Program Files\3D Systems\3D Modeling AcceleratorsBin\Modeler Batch.exe” G:nSt1ModelsSanple_ini C:\St1Model\Sample.txt_

Note: If any of the directories specified in the command script have folders with spaces in the folder name quotes will required around the
directory structure for the script to work. If no spaces are present, the quotes are unnecessary.

Example: "C:\Program Files\3D Modeling Accelerator\Bin\ModelerBatch.exe"

Output Report

After a successful run of the modelerbatch.exe application, the job will be submitted to the designated printer's build queue and the application will
output a report (ReportFile or IniFile) to the location designated in the command script. The figure below is an example of the report output after
the ModelerBatch.exe completion.

£ Sample.ixt - Notepad
File Edit Format Miew Help

[INI FILE]

Status=Mo Errors

[FRINTER]

Status=0ffline

[JOB PROPERTIES]

IF Address=000, 000, 000, 000
[10E - 1ok Mame herel]
Status=rPending

Ln1, Cal1

Printer Status Reporting

Setting up Status INI File

Before running the ModelerStatus.exe, a text file must be created that specifies the desired machine. See example below.



2 Sample.ini - Notepad

File Edit Format Wiew Help

[J0E PROPERTIES]
IF Address=000, 000,000, 000

[12B - {Job Mame Herel}]
[J0B - {1ob2 Mame Herel]|

Ln 5, ol 25
The table below provides a description of the Printer Status INI parameters.
Section Name = Parameter Default Description
Name Value
JOB IP Address N/A IP address of the designated printer, e.g., 192.168.0.2 or 192.168.000.002
PROPERTIES
JOB - N/A N/A The job names are not necessary to request current printer status.
JobName However, individual job status will only be returned to the output ReportFile if the job names are

specified in the INI file.
The job name is formatted as "JOB - username@ComputerName-####", where ####
represents the 4-digit job number.

Running the application
The ModelerStatus.exe application can be invoked from command line or program. The command line format is as follows:
RootDir\bin\ModelerStatus.exe IniFile ReportFile

Descriptions:
RootDir - the installation folder of the ProJet client, which can be obtained from the registry by using:

Key = "HKEY_LOCAL_MACHINE\SOFTWARE\3D Systems\3D Modeling Accelerator"
Name="RootDir"

ReportFile - returns a report to a specified file on the job submission

Note: If a filename is not specified for the report file, the data will be written to a default file named ReportFile.txt. This file will be overwritten every
time the modelerbatch.exe or modelerstatus.exe applications are run without a report file specified.

The DOS window show below is an example of running the Modelerstatus.exe via command window.

osoft Windows XP [Uer n 5.1.26801

(C> Copyright 1985-28081 M;crnsnft Corp.

C:~>C:\"Program Files\3D Systems 3D Modeling ficceleratorsBin\Modeler Status.exe” C:\8tlModel Status.ini C:i\St1lModel\Status.txt,_

Output Report

After a successful run of the modelerstatus.exe application, the application will output a report (ReportFile or IniFile) to the location designated in
the command script. See example below.



[ status.txt - Notepad

File Edit Format Miew Help

[PRINTER] -~
status=Printing T
current Job={1oh Mame Herel}

[12B - {Job Mame Herel]

status=Printing

Start Time=Mon, Oct 26, 2009 09:15 AM

End Time=Mon, Oct 26, 2008 04:30 PM

Total Build Time=00:15

remaining Build Time=07:00

Complete %=2 E
Mumber of Parts=5

Lm &, Caol 23

If building in UHD Mode, "Number of Parts" includes the Verification Strip in the part total.

After a machine is put "Online", there is a period of time that a job takes to initialize. During that time, the Status returned will be "Not Printing" and

the End Time, Total Build Time and Remaining Build Time will all report "Not Estimated". Once the state changes to "Printing", these values will
be reported accurately.

Exit Error Codes

The Printer Batch Processing applications including ModelerBatch.exe and ModelerStatus.exe will return exit error codes if there are any issues

while the application is running. The following table gives a description of each possible error code that may be reported while running either

application.

Exit Error
Code

0

500
501
502
503
504
505

506

507

508

509

510

511

Error Description

No Error

The iniFile is not specified for batch processing

The specified iniFile does not exist or cannot be opened

IP Address field not present

IP address cannot be validated
Number of Parts field does not present
STL file for Part# can not be found

Communication error. Unknown printer type or
unconnectable printer.

Verification Strip file cannot be found.

Wait timeout.

Cannot connect to the printer.

Part outside platform or exceed platform size

Too much part data for Auto Part Placement or Quick
Build Placement

Suggested Solution

Specify the parameter IniFile as the argument

Please make sure the IniFile exist

Add the IP address

Check the IP address

The number of parts must be specified and larger than 0.
Missing the STL file. Make sure it exists and accessible.

Please check IP address.

Reinstall the client or restore the verification strip files.

Please verify the network and increase the wait timeout in the
IniFile.

Please check IP address.

Check the size and position of all parts to ensure that they will fit
inside the platform

Please not use Auto Part Placement or Quick Build.
For example, use Print Preview and manually position the
gemetries.






8.10 Shrink Compensation for ProJet VisiJet® Materials

Material shrinkage occurs in thermoplastics as they transition from liquid state to solid state during the curing process.

The ProJet Accelerator Client Software has features that allow the user to compensate for the natural shrinkage of the material in order to fine
tune the accuracy of a part.

These shrink compensation values serve as general guidelines to setting shrink compensation. Part building and cleaning in a controlled process
will best determine the optimal shrink compensation values for a particular geometry.

SHRINK COMPENSATION VALUES FOR VISIJET® PART MATERIALS

Material Xvalue Y value Zvalue

Navy, Grey & ProPlast = 1.01% 1.01%  0.00%

ProCast 1.01% 1.01%  0.00%
Crystal 0.50%  0.25%  0.00%
Dentcast 1.01% 1.01%  0.00%
Stoneplast 1.01% 0.75% | 0.00%
MP200 0.48% 0.39%  0.00%
DP200 0.5% 0.5% 0.00%

1. Enter Standard Shrink Compensation Values for the material.
a. Open ProJet Accelerator Client software and select the desired printer.
b. Select the part to build.
c. Select the "Options" button.

= = [E[X
wlo/5 O

- il = it =5 = =

5 %0 = "0 = = =3
add modeler engs_xt imc_dp ek me_proped piojet demo  cybercale_progst

For Help, press Fl

3D Systems, Inc.
A=)
hl¢| &lelz| elelelel ol
| Job Name [ Job Stabus Buld Time | Stat Time [ End Time
< >
For Help, press F1 “PROJET DEMO": Online [Thu, Sep 11, 2006 01:27:04 PM_Prodet 3000

I~ Job Name: |
Select Fiez... | | I Dptions II
Job Scale [%}
Mame | Estents <] 1w
Copéez:
= 1
=
< 2| ™ Preparation Only
Cancel

UHD made i cumanty selactad. Chck Oplions to changs.

d. Within the Options panel, enter shrink compensation values for X or Y. Z compensation is rarely necessary (see table above for the values).*



=N

Default Job Options E]

v Verify STL file Shrink Comp (%)
wctFile) [~ Save Verified STL file

X 1.0 o,
- [V Enable Part Placement =
v SaveJob Y 1
I” Quick Build Orientation Z
[~ Shareable - 1
Units

@ Inch  mm .
Frati

BuildStyle: IUHD - Ultra High Definition j

0K I Reset Cancel |

2. |dentify the exact X and Y dimensions of the part using a CAD program.
a. Most CAD programs and simple stl file viewers will provide a way to view a part with its dimensions.
b. Make note of the actual X and Y dimensions as XCAD and YCAD.

3. Build and clean the part and take measurements of the finished part.

a. It is recommended to measure along the critical dimensions of the geometry, take measurements in multiple areas and take an average of
the values.

b. Measurements can be made using calipers or more advanced metrology methods.

c. Make note of the X and Y dimensions of the printed part and mark them as XPART and YPART

NOTE: If the measurement of the finished part is different from the measurements of the CAD model, fine tune the accuracy using
scaling factors.

4. Determine "Scaling Factor" to use for the next build
a. Use the following formula calculate the scaling percentage to be used on the “fine tuning” build:

X Scaling Factor = (XCAD - XPART)/ XCAD * 100 (answer will be as a percentage)

Y Scaling Factor = (YCAD - YPART)/ YCAD * 100 (answer will be as a percentage)

EXAMPLE:

X measurement of CAD model = 3.000"

Y measurement of CAD model = 5.000"

X measurement of printed part = 2.998"

Y measurement of printed part = 4.989"

X Scaling Factor = (3.000 — 2.998)/3.000 *100 = 0.067%

Y Scaling Factor = (5.000 — 4.989)/5.000 * 100 = 0.22%

5. Enter "Scaling Factor" for adjustment build
a. Open ProJet Accelerator Client software and select the desired printer.
b. Select the part to print
c. Open Print Preview to view the part. Select the part (color should be yellow)
d. Select the "Scale" Icon and enter the dialog box to enter the above scaling factors.
e. Uncheck the "Isometric Scale" button. This allows user to make individual x and y adjustments.
f. In the example above the x scaling factor should be 100% + 0.067% = 100.067%
d. The y scaling factor should be 100% + 0.22% = 100.22%
e. Enter these two numbers in the corresponding scaling boxes for x and y.



Scale Selectes], Parts X

[ lsometic Scale | 5

A i) =
100.067 10022 I 100 =

Matice: Input scale walue relatree bo the ongnal model.

Close |

6. Build Part with Scaling Factors and measure
a. Additional iterations of adjusting scaling factors and taking measurements may be necessary with certain geometries.



09.0 Maintenance

The following general maintenance procedures provided must be accomplished to help maintain high part yield and to lower printer's down time.

When changing material bottles during printing, molten material may be present in the MDM holder after the bottle is removed. If a large pool of
material is present (latch is submerged and walls of MDM are reached), do not place a clean material bottle into holder. The holder will require
cleaning before inserting a new bottle.

Caution: The MDM holder and molten material will be hot; avoid touching the sides of the holder during the cleaning process. Wear
heat resistant gloves and goggles.

To Clean:

Insert a lint free cloth to absorb the material in the MDM holder.

Using a long tool, such as tongs; remove the saturated cloth from the holder and place in a waste bag. Continue to clean the holder until
all material is removed.

After the holder is clean, ensure there is no debris or lint left inside of holder.

Dispose of waste material and according to your local codes.

9.1 Cleaning Surfaces

9.2 Cleaning the User Interface Touchscreen
9.3 Cleaning the Waste Drawer

9.4 Cleaning MDM Bottle Holders

9.5 Return Printer for Repair



9.1 Cleaning Surfaces

® Do not remove any outer panels when cleaning the printer. Panels must only be removed by qualified 3D Systems Technical Support
Representatives.

1. Remove dust from outer surfaces of printer by wiping with a clean, dry, lint-free cloth.
2. Remove dirt and grease from printer's outer surface by spraying all-purpose cleaner on a clean cloth and gently wiping.

Caution: Use only non-abrasive, alcohol-free cleaners to clean surfaces. Do not use all-purpose cleaners
containing petroleum-based polishing agents such as liquid wax. Spray cleaner on cloth, not on surface. Do not
use cleaning solvents on build chamber window doing so can damage the protective UV coating.

3. Gently wipe dirt and build material residue from operator control panel using a ammonia-based glass cleaner on a clean, lint-free cloth.

® Remove print platform before cleaning the operator panel. This will prevent the printer from initiating any actions if controls are accidently
pressed.

Cleaning the Material Drawer

Using Isopropyl alcohol and lint free cloth, dampen cloth with the alcohol and clean around the cartridge holders' surfaces. NOTE: Do not clean
cartridge holders when the printer is running. Allow cartridge holders to cool before cleaning the interior of holders.



9.2 Cleaning the User Interface Touchscreen

CAUTION: If the LCD panel breaks, be careful not to get the liquid crystal on your skin. If the liquid crystal touches your
skin or clothes, wash it off immediately using soap and water. If the panel is cracked, and the panel is functional, do not
use the touchscreen, contact your 3D Systems certified service technician or your servicing reseller.

The touchscreen can be clean with a water base solvent such as Simple Green.

Do not Use:

® A dry cloth on the touchscreen*
® Any cleaning products that contains acetone, MEK or alcohol
® Any abrasive cleaning products
® Using these cleaning products can damage the touchscreen.*

NOTE: Before cleaning, the printer must be idle and not printing to avoid aborting a build.

To Clean the Touchscreen:

® Ensure to spray the cleaner onto a soft cloth; do not use a dry cloth or do not spray cleaner directly onto touchscreen.
® Gently wipe the touchscreen to remove debris.




9.3 Cleaning the Waste Drawer

Review VisiJet material handling and disposal safety guidelines in Build Material Safety section of this guide before cleaning the waste drawer.
Clean printer's waste drawer as follows:

1. Verify that the printer is OFFLINE.
2. Wear protective gloves. Refer to Personal Protection Equipment.

3. Open waste drawer and remove waste pan.
4. Dispose of pan if required. Refer to Disposal.
5. Gently scrape any material stuck onto interior surface of waste drawer. Use a flexible plastic scraper to avoid damaging the paint.

6. Vacuum inside waste drawer to remove scrapings.
7. Wipe inside surfaces of waste drawer using a clean cloth and all-purpose spray cleaner. Replace waste pan.



9.4 Cleaning MDM Bottle Holders

Cleaning MDM Holders

When changing material bottles during printing, molten material may be present in the MDM holder after the bottle is removed. If a large pool of
material is present (latch is submerged and walls of MDM are reached), do not place a clean material bottle into holder. The holder will require

cleaning before inserting a new bottle.

Caution: The MDM holder and molten material will be hot; avoid touching the sides of the holder during the cleaning
process. Wear heat resistant gloves and goggles.

To Clean:

® Insert a lint free cloth to absorb the material in the MDM holder.
Using a long tool, such as tongs; remove the saturated cloth from the holder and place in a waste bag. Continue to clean the holder until

all material is removed.
® After the holder is clean, ensure there is no debris or lint left inside of holder.

® Dispose of waste material and according to your local codes.



9.5 Return Printer for Repair

Guidelines for repacking the printer

When shipping the printer for service or repair, use the original shipping carton and packing material. Shipping damage as a result of inadequate
packing is your responsibility. If you have already disposed of the packing material, contact 3D Systems Customer Support for information on

repacking the printer.



10.0 Error Messages

There are three primary types of error messages which could appear on the operator display panel of your printer. The primary types of error
messages found will be Build, Material, and 10.3 Status and Message Lines.
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® 10.1 Build Messages
® 10.2 Material Messages
® 10.3 Status and Message Lines



10.1 Build Messages

Use these messages to help you manage print jobs before, during, and after printing. The causes of and actions to take in response to various
messages are described in the following table:

MESSAGE
XXXX Ll XXXX 2

SUPPORT....2 PART
PRINTING

NOT BUILDING

ProJet™ [X.X] month dd
yYYYTIME XX:XX: XX

CAUSE ACTION

The printer is currently building. None
The display shows the elapse and remaining build time on the top line
and the number of material cartridge in the on the second line.

NOTE
Add material when material cartridges are not in the
material drawer.

The printer is ready to build. Press Play to bring printer online or Main
Menu to view the touchscreen options.

When printer is initially powered-up the latest version of software is None
briefly displayed.

NOTE
This is the ProJet printer's control code version; not the
ProJet Client software version.



10.2 Material Messages

Use the following messages to help manage build jobs before, during,and after building. The causes and actions to take to various messages are
described below:

MESSAGE

#X PART

#X
SUPPORT

ADD PART

CAUSE
The current number of black build material cartridges in the right side of material drawer.

The maximum number of white support material cartridges in the left side of material drawer is
two (2).

The maximum number of build material cartridges in the right side of material drawer is two (2).

ACTION
None

Add support material
cartridges.

Add build material cartridges.



10.3 Status and Message Lines

Messages appear either on the Status line or the Message line. Read both lines together to determine the exact state of the printer. The Status
line generally indicates current state of the printer. The Message line shows the action to take to complete a function and move to the next step.

MESSAGE

ABORT

ABORT
ACKNOWLEDGED

BUILD PAUSED

CLEANING
PRINTHEAD

CLOSE DOORS

CONFIRM
PLATFORM
CLEAR OR
CANCEL

PRESS PAUSE
TO CONTINUE

CYCLE POWER
TO CONTINUE

DONE REMOVE
BUILD

HOMING
PRINTHEAD

HOMING X -Y

INSTALL
PLATFORM

NOT BUILDING

OK TO POWER
OFF

CAUSE

Stop button pressed. Refer to abort build job.

You confirmed an abort command. The printer is
aborting the current job.

PAUSE button pressed during the build. The build
platform moves forward and the chamber door and
waste drawer remain locked. When you press
PAUSE button during a build, the printer completes
its current task before stopping.

The printer is cleaning the build jets.

The chamber door is open.

The printer is prompting you to verify the platform is
clean and clear of obstructions. Refer to installation
of build platform.

The printer is paused.

A severe error occurred. The printer cannot recover
from it and must be switched off.

The printer completed building the current job.

The printer is initializing the Z-axis prior to building.

The printer is initializing the X-axis and Y-axis prior
to building.

The printer cannot detect a platform.

The printer is ready to build.

The printer completed its internal shutdown
procedure and is ready to be shutdown.
Refer to printer shutdown.

ACTION

Press YES to abort
or NO to cancel the
command.

None.
Refer to abort build
job.

Press PAUSE to
continue. Refer to
pause build job.

None. (This occurs
automatically before
every build.)

Close the chamber
door.

Verify the platform is
clean and clear, then
press YES to
continue or press
Stop to cancel.

Press PAUSE to
continue or STOP to
cancel.

Cycle power to the
printer.If the error
message occurs
again, contact your
Technical Support
Hotline.

Remove the
platform. Refer to
removal of build
platform.

None.

None.

Install a clean
platform. Refer to
installation of build
platform.

Press Play to build
or MAIN MENU to
list touchscreen
options.

Toggle power switch
on printer rear panel
to the OFF position.

NOTE

Before you switch power off, verify
you will not need to build parts
again soon. It can take several
hours for the printer to warm up
after you switch power back on.



ONLINE/MENU?

PAUSE
ACKNOWLEDGE

PLEASE WAIT

PRE-JOB
CHECKS

BUILDING

RAISING
PRINTHEAD

REMOVE BUILD

SHUTDOWN IN
PROGRESS

SHUTDOWN
COMPLETE

STANDBY

WAITING FOR
JOB

WARMING STAGE
[4,3,2,1]

The printer is ready to build.

The PAUSE button was pressed. The printer is
acknowledging and complying with the command.

The printer is cooling to shutdown temperature.

Briefly displayed during printer build preparation.

The printer is currently building.

The printer is raising the printhead so you can
remove the platform.

The printer completed a build job and unlocked the
chamber door so you can remove the platform.

You selected the SHUTDOWN MODELER menu
option, then pressed YES twice. The printer is
cooling down so power can be switched off. Refer
to printer shutdown.

Printer cooldown is complete; printer is ready for
power off.

The printer is in energy-saver mode. All internal
subsystems are partially cooled and the printer is
inactive.

The printer is online, but there is no build job in it's
queue. The printer is ready to build as soon as it
receives a job.

The material heaters and printhead jet heaters
gradually warm up to either standby or build
temperature.

Press Play to bring
printer online and to
start build, MAIN
MENU to view
touchscreen
selections.

None. NOTE

Wait for the printer to
complete its
shutdown
procedures. Refer to
printer shutdown.

None.

Allow the build job to
continue or press
PAUSE or STOP to
stop building.

None.

Remove the platform
and replace it with a
clean platform.
Refer to removal of
build platform.

None. DO NOT
switch off the
printer while
shutdown is in
progress.

Wait for OK TO
POWER OFF
message, then
switch power off at
the printer's rear
panel.

None.

The printer will warm
to operating
temperature when
you press any button
or submit a build job.

Submit a build job to
the printer. Refer to
submit a build job.

None.

The numbers on the
Operator's Panel
displays the count
down as the printer
warms up.

At Warming Stage 1
, all heaters and
material are at build
temperature.

NOTE:

If you press PAUSE during a print
job, the current layer or process is
completed before the pause takes

effect.

Before you switch power off, verify

you will not need to build parts
again soon. It can take several
hours for the printer to warm up
after you switch power back on.
Refer to printer shutdown.



11.0 Troubleshooting

If problems occur with the printer, error messages display on the Operator's panel. Refer to appropriate troubleshooting table for assistance.
There may be times when an unrecoverable error message will appear and will require a call toTechnical Support Hotline. Prior to contacting
Technical Support Hotline ensure you have serial number of the printer, a brief description of the problem including exact error message
displayed on the panel, and when the problem occurred (while submitting a job, during the beginning or end of the build, after power off recovery,
etc.).
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11.1 Communication Errors

MESSAGE

RT_ERROR: No machine
Identification (ID)

evm6x_hpi_open()

evme6x_init_emif()

CAUSE

No network
connection.

A communication
error occurred.

A communication
error occurred.

ACTION

Ensure you have a valid network connection. Cycle power to the printer. If error message
occurs again, contact your Technical Support Hotline.

Cycle power to the printer. If this does not restore communication, contact your Technical
Support Hotline.

Cycle power to the printer. If this does not restore communication, contact your Technical
Support Hotline



11.2 Head Maintenance Station Errors

MESSAGE CAUSE ACTION

HMS ERROR  An error occurred during printhead maintenance (cleaning the = Cycle power to the printer. If error message occurs again,
Recovery printhead before beginning a build). contact your Technical Support Hotline.



11.3 Material Feed and Waste System Errors

MESSAGE CAUSE ACTION

RT_ERROR: AirPurge 1 (or 2) | Fault detected in control circuitry. Cycle power to the printer. If error message occurs again,
Not Responding contact your Techncial Support Hotline.

RT_ERROR: AirPurge 1 (or 2) = Fault detected in control circuitry. Cycle power to the printer. If error message occurs again,
Position Error contact your Techncial Support Hotline.

RT_ERROR: AirPurge 1 (or 2) = Fault detected in control circuitry. Cycle power to the printer. If error message occurs again,
Position Error contact your Techncial Support Hotline.

Material 1 (or 2) Pump A new cartridge has been installed but did = Contact your Technical Support Hotline.

Engage Error not satisfy the sensors.



11.4 Material Quality Guarantee Errors

MESSAGE

Support (or build)
material cartridges
not detectedd

Support (or build)
material cartridge
not melted

Support (or build)
material cartridge
expired

Support (or build)
material cartridge
incorrect type

CAUSE

Printer is out of material cartridge.

A cold cartridge was added to the and it did
not have enough time to melt before the
printer requested material.

The material identification system detected
expired material.

A material cartridge was inserted into the
wrong holder.

ACTION

® Add the specified material cartridge, install a clean build
platform and repeat the build job.

® |f error message occurs again, contact your Technical
Support Hotline.

The build will abort if it needs to use the questionable cartridge to
finish the build.

® |nstall a clean build platform and repeat the build job after
the printer has reached build temperature.

® |f error message occurs again, contact your Technical
Support Hotline.

Follow the discard instructions posted on the touch screen.

The build will abort if it needs to use the questionable cartridge to
finish the build.

® Follow the discard instructions posted on the touch screen.

® |f error message occurs again and you have inserted the
correct material cartridge into the correct holder in drawer,
contact your Technical Support Hotline.



11.5 Motion System Errors

MESSAGE

X-Following
ERROR

Negative
Firing
Delay
Pause

Timeout
ERROR

CAUSE

An attempt to open the build chamber door was
made, or position sensor errors occurred.

Variations in scanning axis velocity.

Position sensor contamination.

ACTION

Ensure the build chamber door is secured, then cycle power to the printer.

error message occurs again, contact your Techncial Support Hotline.
Cycle power to the printer. If error message occurs again, contact your

Technical Support Hotline.

Cycle power to the printer. If error message occurs again, contact your
Technical Support Hotline.



11.6 UV Subsystem Errors

MESSAGE CAUSE ACTION
RT_ERROR: UV UV sensor Cycle power to the printer. If error message occurs again, contact your Techncial Support
Lamp Power Too detected a possible = Hotline.
Low fault.
CAUTION

To prevent skin exposure to uncured part material, do not handle parts in a
build without wearing gloves if a UV lamp problem occurred during the
build.



11.7 Vacuum Regulator Errors

MESSAGE CAUSE

RT_ERROR: Printhead Indicates a fault within the
Vacuum Low vacuum system.
RT_ERROR: Printhead Indicates a fault within the
Vacuum High vacuum system.

ACTION

Cycle power to the printer.
Techncial Support Hotline.

Cycle power to the printer.
Techncial Support Hotline.

If error message occurs again, contact your

If error message occurs again, contact your



11.8 Power Outage

If you are present during a power outage, or discover the main power OFF, complete the following steps:

1. Switch power OFF on printer's rear panel so it does not automatically start when power is restored. This prevents printer damage due
to power flickers and surges.

Power
Switch
Power
Ethernet Cord
Connection

1) Bpmrem, e

e

2. When power is restored and stable, switch printer power ON on the rear panel.
If power outage occurs and is restored before anyone can take action, the printer will recover as follows:

The printer advances through warming stages until reaching the required build temperatures. If printer was not building when power outage
occurred, the top line on the LCD panel will display "Not Building" and bottom line will display "Online/Menu?". The printer is ready to
accept a build job.

If printer was building when the power outage occurred, the LCD panel will display "Power Off Recovery" after power is restored and printer has
reached build temperature. This safety feature prevents accessing incomplete build until all build conditions are satisfied. Once occurred, the job
will end, the LCD panel will display "Done Remove Build" and the build platform will move forward, and can be removed and repeat build job if
desired.

NOTE  If the printer is in Power Off Recovery, the build chamber will not be able to open until printer completes recovery.



12.0 Finishing

When the build is complete, refer to the VisiJet® Material Handling and Post-Processing Guide for information on how to detach parts from build
platform, remove support material from parts, and clean parts to a smooth finish.
Basic part coating and equipment maintenance recommendations are also included.


http://3dpedia.3dsystems.com/display/VJHG/Table+of+Contents

13.0 Projet™ Spare Parts List

® 13.1 Consumables and Replacement Modules



13.1 Consumables and Replacement Modules

To view the parts and modules that are available, click on the Projet™ Spare Parts Locator.


http://3dworks.3dsystems.com/display/ProJetSPL/Select+a+Method+to+Find+Part

14.0 Other Documents

14.1 Parts Finisher User Guide

14.2 Material Safety Data Sheets (MSDS- SDS)

14.3 Projet™ Quick Reference Guide

14.4 Facility Requirements Guide

14.5 VisiJet® Material Handling and Post-Processing Guide



14.1 Parts Finisher User Guide

When the build is complete, refer to the Parts Finisher Guide for information to detach parts from build platform, remove support material from
parts, and clean parts to a smooth finish.
Basic part coating and equipment maintenance recommendations are also included.



14.2 Material Safety Data Sheets (MSDS- SDS)

To obtain a copy of the Material Safety Data Sheet (MSDS) or a Safety Data Sheet (SDS), click on the 3D Systems MSDS/SDS link. 3D Systems
MSDS/SDS


http://production3dprinters.com/support/3dp-material-safety-data-sheets-msds
http://production3dprinters.com/support/3dp-material-safety-data-sheets-msds

14.3 Projet™ Quick Reference Guide



14.4 Facility Requirements Guide

Projet™ 3-D Modelers Facility Requirements Guide


http://3dWorks.3dsystems.com/pages/viewpage.action?pageId=11698237

14.5 VisiJet® Material Handling and Post-Processing Guide

VisiJet® Material Handling and Post-Processing Guide


http://3dpedia.3dsystems.com/display/VJHG/Table+of+Contents

15.0 Service and Support

¢ 15.1 Contacts
® 15.2 How to Order Parts



15.1 Contacts

For information, questions, or comments about your ProJet™ 3-D printer system(s), VisiJet® materials, or request service, please contact a
3D Systems Customer Service or Sales Representative nearest you.

3D Systems

333 Three D Systems Circle
Rock Hill, SC 29730 USA

tel: 803.326.4080

fax: 803.324.8810

toll free: 800.889.2964

email: moreinfo@3dsystems.com
www.3dsystems.com

Nasdaq: TDSC

Customer Support Hotline
U.S.A. 800.889.2964
Asia-Pacific (+852) 29 23 50 77
Europe (+49) 6151 357-0

Sales and Service

FRANCE tel (+33) 169 35 17 17 ITALY tel (+39) 039 68904 00
GERMANY tel (+49) 6151 357-0 JAPAN tel (+81) 3 5451-1690
HONG KONG tel (+852) 292350 77 UK tel (+44) 1442 282 600

SWITZERLAND tel (+41) 26 439 95 90


http://www.3dsystems.com/

15.2 How to Order Parts

New and refurbished parts made by 3D System's manufacturer are used when performing warranty repairs and in building replacement parts and
systems. Refurbished parts and systems, are parts or systems that have been returned to 3D Systems, some of which were never used by a
customer. All parts and systems are inspected and tested for quality. Replacement parts and systems are covered for the remaining period of the
limited warranty for the product you bought. 3D Systems owns all parts removed from repaired products.

To order replacement parts, contact 3D Systems Customer Service Support or contact your local reseller.

When contacting 3D Systems Customer Service Support, have your printer serial number available to give to customer support.



16.0 Online Help

Find Help topics on the Content Pages of each section.

16.1 Frequently Asked Questions (FAQ)
16.2 Getting Help

16.3 Build Material

16.4 Printer Hardware and Installation
16.5 Facility Requirements



16.1 Frequently Asked Questions (FAQ)

General

What is rapid prototyping?

Rapid prototyping(RP)is the process of building a part from a 3D Cad drawing and converting the drawing format into an .STL file. When the
printing event takes place in the printer, it is constructed layer by layer using Accura VisiJet® materials.

What is 3D printing?
A type of rapid prototyping, typically defined by faster, more affordable, and easier-to-use technologies.

How does 3D Printing fit into the design process?

For a growing segment of designers using 3D CAD drawing, the ProJet Printer is quickly becoming an essential extension of overall CAD systems
and a critical part of the entire design process by:

® Accelerating Time to Market - through shortening design and development cycles and ultimately get products to market more quickly
enabling users to easily fine tune design and explore multiple design configurations.

® Generating Savings - by helping companies significantly lower production costs and reducing expensive revisions late in the development
cycle.

® Enhancing Communication and Collaboration - through bringing ideas off flat screens and producing functional parts that can be easily
shared, critiqued, and improved upon.

® Creating Better Designs - designers are no longer limited to the number of parts they can produce and test, resulting in more creative
designs and better final products.

® Ensuring Confidentiality - eliminating the need to exchange confidential design files with service providers, allowing companies to
maintain product confidentiality and control.

How does the 3D Printing process work?

The printer builds functional 3D prints from the bottom up, one layer at a time.

STL files are imported into the printer that automatically slices and orients the parts and creates any necessary support structures. The materials
are fed into the printer in a heated semi-liquid state and accurately deposited in layers upon the build platform. After completion of the build,
support structures are simply removed through a post curing process.

How do materials create accurate, detailed, and durable parts from your 3-D CAD designs?

Popular applications include concept parts, casting forms, prototype parts, and specialty tools. All the specific physical and process characteristics
of VisiJet materials are detailed in VisiJet material safety data sheet.

Is post-processing required?
Yes, upon removing the part from the printer you will need to remove the support material from VisiJet® parts. The parts finisher makes removing

bulk support material from VisiJet parts efficient and easy. Forced airflow and precision temperature control deliver faster, shorter, and more
predictable VisiJet part finishing times.

Are there any special facility requirements or operating systems necessary to install and operate the printer?

Refer to the ProJet™ 3-D Printer Facility Requirements Guide.

Can more than one user process files and build parts?

Multiple users can send files to the printer build queue, move, delete, and set build priorities in the build queue. Depending on the size of the part,
multiple files can be added onto the build platform in one build application.

Can parts be sanded, painted, dyed, and glued?

The parts can be sanded to remove imperfections or layer lines from the surface. After priming, the parts can be painted using any oil- or
water-based paint that is compatible with the primer, or you can dye VisiJet parts with candle-craft dyes. You can also use super glue to join parts
together.



What is Computer-aided design (CAD)?

Computer-aided design (CAD) is use of a wide range of computerbased tools that assist engineers, architects and other design professions in
their design activities. It is the main geometry authoring tool within the Product Lifecycle Management process and involves both software and
sometimes special-purpose hardware.

What is a .STL file?

A .stl file is a format used by Stereolithography software to generate information needed to produce 3D parts on Stereolithography machines. It is
a triangular representation of a 3-D object. The surface of the object is broken into a logical series of triangles. These triangles represent the
surface of the object.

How do | export an STL file from my 3-D CAD program?

Most CAD software offers STL conversion add-ins.

Are the build platforms reusable?

Yes the build platforms are reusable.

How many builds can one material cartridge produce?

This depends on the size and the complexity of the part being built.

If material runs out before the part has completed the build process, does the build abort?
Yes the build will be aborted. Ensure that there is sufficeint amount of materials to complete the build.

When submitting a build, will the 3-d modeling client software inform me if the amount of material is sufficient for
completing a build?

The client software will tell you how many cartridges it will take to complete the build.
How do | order parts?

To order replacement parts you will need to contact 3D Systems' Customer Support.


http://www.3dsystems.com/company/contact.asp

16.2 Getting Help

This section provides quick access to operating, maintenance, troubleshooting, spare parts locator and contact information to 3D Systems
Customer Support Centers.

® Projet Spare Parts Locator
® Material Safety Documentation, 3D Systems MSDS
® Contact 3D Systems Corporation


http://www.3dsystems.com/services/materials/index.asp

16.3 Build Material

Build Material Safety Guidelines

Material Disposal
Material Handling
Material Safety
Material Usage
Spilled VisiJet Material
Waste Removal



16.4 Printer Hardware and Installation

This section describes the printer setup appications and functions.

Client Hardware & Network Interface
Electrical

® Electrical Safety
® General Safety Guidelines

Ultraviolet (UV) Safety

Unpacking Printer

Network and System Setup

Install Material Cartridges and Print Platform
Installing & Removing Build Platform
Build Process & Previewing Build
Printer Status

Abort Build

Part Removal

Shutting Down System

Notification Messages

Return Printer for Repair



16.5 Facility Requirements

The requirements for electrical and room preparation are specified in the Projet™ 3000 Facility Requirements Guide.


http://3dWorks.3dsystems.com/pages/viewpage.action?pageId=11698237

17.0 Glossary of Terms

Build Platform - this part is used by the printer to build parts. Support structures link the part to the build platform and must be removed from the
printer once complete.

.stl File -- is a 3-dimensional solid Computer-aided design (CAD) software system used to produce parts.

Material Quailty Guarantee - the printer reads an encrypted RFID tag on the cartridge to communicate parameters and ensure optimum build
quality.

Chamber Door - the chamber door prevents harmful UV radiation from escaping the build chamber during the build process. The chamber door
must be closed prior to starting or resuming a build job and is locked when a build is in progress.

Printing - the printer uses part and support material to create 3-dimensional plastic prototype parts.
Operator Panel - is used to display build job status, menu options, and command prompts for the printer.

Support Material - is a wax based material that provides adhesion to the build paltform and support for down facing surfaces and open volumes
within the parts.

Build/Part Material - is a paste-like acrylic compound that is an ultraviolet (UV) curable material.
ProJet Client Software - is used to setup, run, and manage build jobs.

Shrink Comparison Percentage (Shrink Comp %) - is used to adjust for expected shrinkage during the build so actual part dimensions more
closely match actual dimensions.

Job Scale Percentage (Job Scale %) - is used to resize parts during the build process.

Material Delivery System - stores and feeds the materials to the printer during the build process. The MDM hold two support cartridges and two
part cartridges.

Waste Material - is any uncured support and/or build material generated during a build process.

Debug Log - is a text file used for obtaining information for resolving potential problems that may occur with the printer.
X-Axis - is the orientation of the part from front to rear on the build platform.

Y-Axis - is the orientation of the part from left to right on the build platform.

Z-Axis - is the orientation of the part height on the build platform.

Post Curing (Finishing) - is the final process to remove support material from parts and clean the parts to a smooth finish prior to surface finishing
and coating.
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